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A képzési oktatasi cél:

A képzés célja a hallgatok megismertetése a vektorgrafikus rendszert programok
tulajdonsagaival és az AutoCAD hasznalatanak alapjaival:

— a CAD programok altalanos mitkddési elvével,

— arajzszerkesztés ¢és a rajz formai egységeivel,

— rajzos dokumentum eléallitasdnak modszerével,

— arajzszerkesztés funkcidival,

— arajzfijlok mas alkalmazasokba val6 konvertalasaval,
— a szilardtest-modellezés alapjaival.

A segédanyag irdsakor a legujabb, 14-es verzio volt az irdnyad6. Mivel az oktatas korabbi
programok segitségével is folyhat, ezek eltéré miikodésésére tobb helyen is utalas talalhato.

A segédanyag irdsakor irdnyado volt a rovid terjedelem, ennek kovetkeztében csak a
legsziikségesebb ismeretek dsszefoglalasara volt lehetdség. A részletes anyag a szerzo a segédlet
irasakor még meg nem jelent fdiskolai jegyzetében lesz megtalalhato.

Szakmai kovetelmény:

A hallgato legyen képes 6ndlloan rajzok szerkesztésének, méretezésének, modositasdnak
elvégzésére.

Sziikséges eldismeret:

A hallgatonak a képzésben vald eredményes részvételhez a kovetkezd ismeretekkel kell
rendelkeznie:

— amiuszaki rajzok abrazoléas-technikajanak ismerete,

— az oktatott CAD program operacids rendszerének alapvetd ismerete,
— abillentylizet ¢és az egér kezelésének ismerete,

— aszamitdgépes adattarolas elvének ismerete,

— minimalis angol nyelvismeret.

Ajanlott irodalom

Pintér Miklos: Rajzkészités AutoCAD Release 12 verzidval
Computer Books Kft Budapest, 1994

Pintér Miklos: Szilardtestek modellezése AutoCAD Release 12 verzidval
Computer Books Kft Budapest, 1993

Pintér Miklos: Az AutoCAD R13 szerkesztési ujdonsagai
Computer Books Kft Budapest, 1995

A CADvilag cimi, kéthatvonta megjelend magazin
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Ezlton szeretnék kdszonetet mondani Jakubek Lajos fdiskolai adjunktusnak a lektoralds soran
nyujtott hasznos észrevételeiért.
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1. ALAPFOGALMAK, A PROGRAM KEZELOSZERVEI

Az itt ismertetett fogalmak, illetve beallitdsok nagy részét nem csak az AutoCAD kiilonb6z6
verzidi hasznaljadk, hanem sok madas vektorgrafikus rendszerben is szerepelnek (a kezelésiik
természetesen eltéro lehet).

1.1. PARANCSOK KIADASA, A PARANCSSOR ES A MENUK
HASZNALATA

1.1.1. A program inditasa

A windowsos verzidkban az erre szolgald parancsikonnal indithatjuk a programot. DOS alatt
az inditas nem az acad.exe f3jllal, hanem a telepitéskor erre a célra létrehozott acadrl3.bat
(acadrl12.bat) nevl allomannyal torténik. Ez azért fontos, mert a miikodéshez sziikséges fajlok (pl.
meniik vagy betiikészletek) helyét csak igy taldlja meg a program.

1.1.2. Az aktualis rajz mentése

A mentést a File menii > Save parancsaval végezhetjiik. Uj néven is menthetjiik a rajzot
(File > Save As), valamint konvertalhatjuk azt (File > Export) koztes formatumokba (pl.
DXF, Windows Metafile, stb.).

1.1.3. Kilépés a programbdl

A File &> Exit paranccsal zarhatjuk be az AutoCAD-et, amely kilépés el6tt rakérdez az
aktualis allomény valtozasainak elmentésére.

1.1.4. Egérfunkciok

CAD programok hasznalatahoz kiilonosen fontos a megfeleld mindségli pozicionald eszkoz
(egér vagy digitalizalo tabla). Utdbbi a szamitogépes tervezés specialis eszkoze, épp ezért kevésbé
elterjedt, és dragabb periféria, mint az egér.

Az egérgombok funkcioi:

Bal gomb: meniik kezelése, pontmegadas, kijelolés.

Ko6zéps6 gomb: a pontfogds meniijének megjelenitése (I1asd: Object Snap). Kétgombos egérnél a
k6zEépsdé gomb Ctrl + jobb gombbal helyettesithetd.

Jobb gomb: parancsfunkciok lezarésa, az utoljara kiadott parancs ismétlése.

Ezen kiviil a kdvetkezd kombinaciokhoz definidlhatunk miiveleteket (részletesen: Jegyzet,
Testreszabas fejezet):

— Shift + bal gomb,

—  Shift + k6zépsé gomb,
—  Shift + jobb gomb,

— Ctrl + bal gomb,
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—  Ctrl + kdzéps6 gomb,

— Ctrl + jobb gomb,

— Ctrl + Alt + Shift + bal gomb,

—  Ctrl + Alt + Shift + k6zépsé gomb,
— Ctrl + Alt + Shift + jobb gomb.

1.1.5. Parancsok kiadasa
Az AutoCAD parancsait négyféleképp adhatjuk ki:

— egérrel, a képernyd felsd részén 1€vo legordiilé meniibol,
— egérrel, a képernyd jobb szélén 1évo képernyd meniibol,
— Dbillentylizettel, a képerny6 aljan 1év parancssorbodl,

— windows alapu verzioknal egérrel, az eszkoztarakbol.

Ha még a befejezése elott ki akarunk 1épni egy parancsbol (pl. ha véletleniil adtuk ki), azt az
Esc billentytivel vagy a jobb oldali képerny6é menii AutoCAD feliratara vald kattintassal tehetjiik
meg.

A parancsok tobb kategoridba sorolhatok (az eszkoztarak és meniik felépitése is ezt a
csoportositast koveti):

— altalanos fajlmuaveleteket végzo parancsok (megnyitas, mentés, konvertalas, nyomtatas, stb.)

— a Windows és az OLE kezeléséhez kapcsolodo parancsok (masolas, kivagas, beillesztés)

— 1j rajzelemeket 1étrehozd parancsok (vonal, iv, kor, stb. rajzolasa)

— 1j rajzelemeket meglévdek alapjan 1étrehozo parancsok (tiikrozés, kiosztas, extrudalas, stb.)

— meglévo rajzelemeket modositd parancsok (meghosszabbités, vagas, nyljtas)

— aszerkesztést segitd altalanos parancsok (visszavonas, kijeldlés, stb.)

— amegjelenités beallitdsat végzd parancsok (Zoom, Pan, 3D Dynamic View, stb.)

— arendszer ¢és a segédeszkozok kiillonbozo beallitasait végzd parancsok (vonaltipusok, pontfogas
beallitasa, stb.)

A kiilonboz0 kategoriak egyes parancsainak alkalmazasa hasonlé metodika szerint torténik.
A parancsok alkalmazasa soran pontok koordinatait, illetve rajzelemeket kell kijeldlniink, valamint
kiilonboz6 opciodkat kell megadnunk. Azt, hogy az adott parancs kovetkezd 1épése mit var tdliink, a
parancssorbol tudhatjuk meg.

1.1.6. A parancsok Preview funkcidja

Az AutoCAD igen hasznos tulajdonsaga az, hogy rajzolas kdzben mar elézetesen lathatjuk a
varhatd eredményt. Pl.: egy ivet meghuzhatunk harom pontjanak (kezddpont, kézbensé pont,
végpont) megadasaval. Ha megadtuk a kezdd- €és a kdozbensd pontot, a végpont kijeldlése eldtt mar
megjelenik az iv, amelynek végpontja a szdlkereszt aktudlis helyén van. Ez az iv dinamikusan
koveti a szalkereszt mozgasat, azaz a szalkereszt mozgasanak megfelelden valtozik az alakja. Az
elézetes iv szine fehér (vagy fekete, a hattér szinétdl fiiggden), a megfeleld szinre a harmadik pont
kijelolése, azaz a parancs befejezése utan valt at. Ugyanez igaz a tiikkr6zésre, sraffozasra,
méretezésre, stb.
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1.1.7. A parancssor hasznalata

A parancssor a képerny alsé részén talalhatd szoveges mezd (3. dbra). Itt olvashatjuk a
program tizeneteit, és ide gépelhetjik be a sziikséges adatokat. Nagysagat tetszés szerint
beallithatjuk, alapértelmezettként harom sor jelenik meg a képernydn. A parancssor teljes ablakat
DOS-os verzioknal az F1, windowsosoknal az F2 billentytivel jelenithetjiik meg.

Ha egy parancs végrehajtdsa folyaman tobb lehetéség koziil valaszthatunk, az
alapértelmezett opcid a parancssorban < > zardjelben van. Ugyanez a helyzet a parancs utolsd
hasznalatakor megadott értékkel is. Ezeket nem kell 0jbol begépelniink, lires Enter letitésével a <>
zardjelben 1évo tagot valasztjuk ki, pl.:

Command: circle 3P/2P/TTR/<Center point>: Diameter/<Radius>:

A kor rajzolasanal alapértelmezettként eldszor a kdzéppontot (Center point), majd a sugarat
(Radius) kell megadnunk.

Az opcidk kiadasa a megfeleld sz6 nagybetiiinek begépelésével torténik. Ez legtobbszor a
szo elsé betlije (ha az elobbi példanal a sugar helyett az atmérét akarjuk megadni, d-t kell
begépelniink), de tobb betti is lehet:

Command: chprop
Change what property (Color/LAyer/LType/ltScale/Thickness) ? la

Az la begépelésével a LAyer opciot valasztottuk ki.

Lehetdségiink van a parancssor ablakénak gorgetésére is (windowsos verzioknal), valamint a
szoveg kezelésére (masolas, beillesztés mas alkalmazas dokumentumaiba, stb.). Ezen kiviil
bemutato6t is tarthatunk a rajz készitésérol.

Az utoljara kiadott parancsot nem csak az egér jobb gombjaval, hanem a parancssorba {itott
ires Enterrel is elindithatjuk.

A leforditott verziok (igy a magyar nyelvli AutoCAD) a parancssorba gépelve megeértik az
eredeti, angol parancsokat is. Ehhez azonban a parancs neve elé _ jelet kell gépelniink, pl. _insert.
Ez a nyelvsemleges parancsmegadas.

1.1.8. A legordiilé6 menii hasznalata
A leg6rdiild meniit a Windowsban megszokott médon hasznalhatjuk:
— egérrel, a megfelel6 meniipontra kattintva,
— Dbillentylizettel: az Alt billentyiivel 1éphetiink a meniibe, ott a kurzorgombokkal vagy az
alahuzott gyorsbillentylikkel mozoghatunk, a parancsokat Enterrel adhatjuk ki.

A meniiben haromféle meniipontot kiilonboztethetiink meg:

— Ha a meniipont neve mellett kis haromszog (jobbra mutat6é nyil) lathatd, az egy almeniit nyit
meg.
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Ha harom pontot latunk, a meniipont egy parbeszédablakot jelenit meg, itt végezhetjiik el a
kiilonb6z6 bedllitasokat. Ha rajzelemek kijeldlésére is sziikség van a parancs végrehajtasa sorén,
akkor ezt a parbeszédablak egy nyomdgombja teszi lehetové. A kijeldlés utan visszatérhetiink
az ablakhoz.

Ha a meniipont neve mellett nem lathaté nyil vagy harom pont, akkor az olyan parancsot indit
el, amelynek nincs parbeszédablaka.

Az AutoCAD meniiinek igen hasznos tulajdonsaga, hogy szabadon alakithatéak. Az

alapértelmezett meniifajl a program konyvtaraban acad.mnu nevii szdveges fajlként is szerepel.
Ennek atirdsaval, majd betoltésével gyakorlott felhasznalok szdmdara nem jelenthet gondot Uj
mentiipontok, billentyiiparancsok vagy egérfunkciok létrehozésa.

1.1.9. A képernyd menii hasznalata

A képerny6 meniit is egyarant hasznalhatjuk egérrel (a DOS-o0s verzidknal tigyelniink kell

arra, hogy a rajzteriiletrél és ne a legordiilé6 meniir6l huzzuk az egeret a képernyé meniire) vagy
billentytizettel (Insert billentyii, mozgés a kurzorok vagy Ctrl + kurzorok segitségével, kivalasztas
Enterrel).

A 14-es AutoCAD-ben alapértelmezett beallitas szerint a képernyé menii nem jelenik meg.

Bekapcsolasat a Tools = Preferences paranccsal végezhetjiik el:

Preferences

Dra window parameters
¥ Digplay &utoCAD screen menu in drawing window

v Digplay scroll bars in drawing window

1. abra

Ugyanitt jelenithetjiik meg a gorditdsavokat is, valamint a parancssor tulajdonsagait.

A képernyd menii a kovetkezd részekbdl all:

Legfeliil egy AutoCAD felirat olvashatd. Ezzel szakithatjuk meg az aktudlis parancs
végrehajtasat, illetve 1éphetiink ki a képernyd menti gyokerébe.

Ez alatt négy csillag lathato. Ezekre kattintva el6hivhatjuk az Object Snap-et.

A csillagok alatt lathat6 a menii: FILE, EDIT, VIEWI, VIEW2, INSERT, stb. Ezek
valamelyikére kattintva egy almeniibe jutunk, pl. a FILE megjeleniti a New, Open, Qsave,
Saveas, stb. parancsokat. Ha a teljes almenii nem fér el a képernyOn, akkor abban a Next ¢€s
Previous feliratokkal mozoghatunk.

A menii alsé részén két allanddé meniipont lathatd: ASSIST ¢s LAST. Az ASSIST a rajzelemek
kijelolésében van segitségilinkre, a LAST pedig az utoljara hasznalt almeniit hivja eld.

A képernyd mentii atalakitasat is az acad.mnu f4jl segitségével végezhet;jiik el.
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1.2. KOORDINATARENDSZEREK, PONTMEGADAS

A CAD programok jellemzden nem csak egy koordinatarendszert hasznalnak. Az AutoCAD
koordinatarendszereinek részletes ismertetése a jegyzetben megtaldlhato, ezek koziil kettot kell
kiemelniink: a vilag- és a felhasznaldi koordinatarendszert.

1.2.1. Vilag-koordinatarendszer: WCS

Ez a rendszer dalland6. Nem tudjuk sem eltolni, sem elforgatni. Jobbsodrasu
koordinatarendszer, tehat ha az X tengelyt az Y tengelybe forgatjuk, a Z tengely a forgasirdnynak
megfelelden a jobbemelkedésti menet mozgasiranyat jeloli ki.

1.2.2. Felhasznaloi koordinatarendszer: UCS

A koordinatakat a szerkesztés soran a felhasznal6i koordinatarendszerben adjuk meg. Az ezt
jelképezd ikon megjelenitése valtoztathatoan altaldban a képernyd bal alsd sarkaban lathatd. Ez a
rendszer a program induldsakor egybeesik a WCS-sel, de az UCS-t el tudjuk tolni és el is
forgathatjuk ebbdl a helyzetbdl, a program tehat a vilag-koordinatarendszerbdl transzforméciokkal
hozza létre a felhasznaloi koordinatarendszert. igy mindig az adott rajzrészletnek vagy modellnek
megfeleld koordinatarendszerben tudunk dolgozni. A kiilonbozé UCS-eket el is tudjuk menteni a
rajzon beliil, majd minden feladatnal betolthetjiik az annak megfelelét. Ez az egyik oka annak, hogy
a tévhittel ellentétben az AutoCAD-del val6 rajzolas kozben nem kell fejben szamolnunk.

1.2.3. Polar-koordinatarendszer

Egy pont, pl. egy vonal végpontjdnak kijelolésekor kétféleképp hasznéalhatjuk a
koordinatarendszereket. Megadhatunk abszolut koordinatakat, illetve a pont helyét megadhatjuk
relativ mdédon, a vonal kezddpontjahoz képest. Ez esetben a vonal hosszat és az irdnyat kell

megadnunk. Ha pl. egy 60 egység hossza ¢és 30 fokban emelkedd vonalat kivanunk htizni, akkor a
kezddpont kijelolése utdn a végpont megadéasakor a kovetkezdket kell begépelniink: [@60<30].

1.2.4. Szogmegadas

Szogértekek megadasanal iigyelniink kell az eldjelekre. Az alapértelmezett beallitas szerint a
0°-ot az X tengely pozitiv iranya jeloli ki, a pozitiv forgasirany az 6éramutato jarasaval ellentétes,
tehat az Y tengely pozitiv irdnya a +90°.

1.2.5. A szialkereszt megjelenése, hasznalata

Az aktualis funkciotdl fiiggden az egérmutatod kiillonbozo alakokat vehet fel:

r'L | O £ O

[ | ‘

2. abra

Az abréan lathato els6 megjelenési forma arra utal, hogy épp nem hajtunk végre parancsot.
Ilyenkor a szalkereszt rajzelemek kijelolésére szolgal. A DOS-os verzioknal hasonld szalkereszt
szimbolizalja a pontfogast (lasd: Object Snap), parancs végrehajtasa kozben. A metszéspontban a
négyzet mérete ekkor alapértelmezettként nagyobb, mint az el6z6 esetben.
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A masodik kereszt kozepén nincs kis négyzet. Ez arra utal, hogy parancs végrehajtasa
kézben egy pontot kell megadnunk. A 14-es AutoCAD pontfogaskor a szdlkereszt mellett
megjeleniti a megtalalt jellemz0 pont jelképes ikonjat (5. abra).

A 2. abra utolsé két egérmutatdja a 14-es AutoCAD Realtime Pan és Realtime Zoom
megjelenitd funkcioit szimbolizalja.

A szalkereszt mozgatasa torténhet a pozicionald eszkozzel vagy sziikség esetén
billentytizettel:

— DOS-os verzioknal a kurzorbillentytiikkel,
— windowsos verzioknal Ctrl + kurzorbillentytikkel.

A kurzorbillentylis mozgatas finomsagat a Page Up és Page Down (Ctrl + Page Up, Ctrl +
Page Down) billentytikkel éllithatjuk be.

Lényeges tulajdonsag, hogy ha a billentylizettel mozditottunk a szalkereszten, az egér nem
mozgatja azt tovabb, hanem visszaallitja azt az eredeti pozicioba. (DOS-os verzidknal ehhez
Escape-et kell nyomnunk.)

1.2.6. Pontmegadas

A pontok koordinatait meg tudjuk adni egérrel vagy a parancssorba valo begépeléssel. Ha
utobbit valasztjuk, iigyelniink kell arra, hogy az AutoCAD tortek megadasara tizedespontot hasznal,
a vesszé az X, Y ¢és Z koordinatédkat valasztja el. A pontmegadas egér esetében a bal gombbal,
billentytizetrdl pedig az Enterrel torténik.

Az egérrel egy pontot megadhatjuk csupéan a koordinatarendszer alapjan, de hasznalhatjuk a
mar megrajzolt rajzelemeink jellemzd pontjait is, pl. egy kor kézéppontjat, egy vonal végpontjait
vagy felezépontjat, stb.). Ez az Object Snap vagy Targyraszter funkcid, amit az egér kozépsd
gombjaval vagy kétgombos egér esetén Ctrl+jobb gombbal hivhatunk eld. Ez biztositja a kelld
pontossagot, és gyorsitja a pontmegadast is, mert nem kell rakozelitenilink az adott rajzrészletre, és
nincs sziikkség az egér nagyon preciz mozgatasara sem, elég ha a kijeldlni kivant jellemz6 pont
kdrnyezetére mutatunk.

Ezek a jellemzdé pontok (grip-pontok) parancs kiadadsa nélkiil is modosithatok, ezért
hasznalatuk jelentds mértékben gyorsitja a szerkesztést. Ha a modositani kivant rajzelemet
kivalasztjuk, az szaggatottd valik, és a jellemzd pontjain kis kék négyzetek jelennek meg. Ha ezek
valamelyikére ramutatunk az egérrel, a szine pirosra valt, ekkor el tudjuk mozditani. A rajzelem
ennek megfelelden valtozik meg. (Az inaktiv és az aktiv grip-pont szine tetszés szerint beallithato.)
Egy vonal és egy kor grip-pontjai lathatoak a 6. dbra also részén.

1.2.7. Hosszmegadas
Bizonyos parancsoknal a végrehajtas sordn kiillonb6z0 hosszértékeket is meg kell adnunk.
Ilyen példaul a lekerekités sugara, az élletdrés nagysaga, sikidom extrudalasanak magassaga, stb.

Ezt a hosszmegadast tobbféleképp is elvégezhet;jiik:

— ahosszértéket begépelhetjiik a parancssorba,
— kijel6lhetiink két pontot az X-Y sikon az egérrel, ezek tdvolsagat megadva,
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hasznalhatjuk a program beépitett szdmologépét, igy egy meglévo rajzelem bizonyos geometriai
jellemzdibdl hatarozhatjuk meg a megadni kivant hosszt.

1.3. A STATUSZSOR ES A FUNKCIOBILLENTYUK HASZNALATA

A statuszsort az F10-es funkciobillentyiivel jelenithetjik meg vagy tiintethetjiik el

(windowsos verzioknal). A régebbi, DOS-os verzioknal a képernyd felsé, windowsos verzioknél a
képernyd alsé részén, a parancssor alatt lathato (3. abra):

Cornand
AutoCAD menu utilities loaded.

Cornarc] @

[136.5000,32.0000 ,0.0000 [SHAR [GRID [DRTHO |OSMAR [MODEL |TILE

3. abra

1.3.1. Koordinatak

A koordinatak megjelenitésének harom maddja van:
be van kapcsolva (folyamatosan kdveti a szalkereszt mozgasat), és mindig az abszolut értékeket
mutatja (X, Y és Z koordinata),
ki van kapcsolva, és mindig az utoljara kijelolt pont abszolut koordinatait mutatja (nem kdveti a
szalkereszt mozgasat),
be van kapcsolva, parancs-végrehajtason kiviil az abszolut, parancs végrehajtdsakor a relativ
értékeket mutatja (hossz- és szogérték az utolso ponttol).

A hérom éllapot kozt az F6 billentytivel valthatunk, ebben a sorrendben.

1.3.2. Snap

Az AutoCAD precizitasa alapértelmezettként 0,0001 rajzegység. Nyilvanvalo, hogy az

egeret szokvanyos nagyitas mellett nem tudjuk ilyen pontosan mozgatni. Ha csak ,,szemre” adnank

meg az egérrel a koordinatdkat, a rajzunk pontatlan lenne, és ez megnehezitené¢ a tovabbi

szerkesztést.

Probaljuk ki a kovetkez6t: kapcesoljuk ki a Snap-et, huzzunk egy vonalat a Draw menii 2>

Line parancsaval, majd Iépjiink ki a parancsbol. Probaljunk meg egy masik vonalat huzni az el6z6
valamelyik végpontjabdl, pontfogas nélkiil (lasd: Object Snap). Nagyitsuk ki a View > Zoom >
Window paranccsal a két vonal metszéspontjat. Lathatd, hogy a két végpont nem esik egybe.

A Snap funkcié bekapcsolt allapotaban az egér a szalkereszt koordinatait adott 1épéskozzel

valtoztatja. Ezt az ért¢ket legegyszeriibben a parancssorbol allithatjuk be:

Command: snap

Snap spacing or ON/OFF/Aspect/Rotate/Style <0.5000>:

Az opciok elérhetéek a Tools 2 Drawing Aids itvonalon is.
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A Snap-et az F9 billentytivel vagy windowsos AutoCAD-eknél a statuszsor SNAP feliratara
vald kattintdssal tudjuk ki-be kapcsolni. A rajz pontossidga érdekében csak objektumok
kijelolésénél, illetve szabadkézi vonal htizasanal kapcsoljuk ki a Snap-et.

1.3.3. Grid

A Grid bekapcsolasaval racspontokat jelenithetiink meg a rajzon. Ez a funkcié a kockas
papirhoz hasonlo segitséget nyujt a rajzolasban. A racspontok tavolsaga és elhelyezkedése allithato.
A racspontok foleg izometrikus nézetek rajzolasanal nytjthatnak segitséget.

A Grid az F7-tel kapcsolhaté be és ki. A beallitdsok leggyorsabban a parancssorbol
végezhetdk el:

Command: grid

Grid spacing(X) or ON/OFF/Snap/Aspect <10.0000>:

Akarcsak a Snap esetében, a Grid beallitasait is tudjuk modositani a Tools = Drawing Aids
paranccsal.

1.3.4. Ortho

Az Ortho funkcié megkonnyiti a vizszintes és fiiggdleges (pontosabban fogalmazva az X és
Y irdnyu) vonalak huzasat, illetve a hasonld irdnyu pontkijeldlést. (Természetesen nem csak
rajzolas kozben, hanem minden olyan koordindtakijel6lésnél miikodik, ahol egymas utan két pontot
adunk meg. Ilyen példaul a tiikkrozés tengelyének kijelolése.)

A kezdOpont megadasa utan azt, hogy vizszintes vagy fiiggéleges vonalat huzunk (vagy
jeloliink ki), a szalkereszt kezddponttdl mért relativ helyzete donti el:

1. 2. 1. 1.
\\ \\ \\ 2
N ~
AN N h
~ ~ >
~ N ~
AN AN h
AN N h
~ ~ >
~ N ~
AN N
S
v 2. v .
~ N ~
d b C
4. abra

A vonal masodik pontjanak helyzetét az Ortho bekapcsolt allapotaban az donti el, hogy a
szalkereszt a kezddponttdl hiizott 45°-0s egyenes (a képernydn nem jelenik meg) alatt vagy felett
van (1. abra, a, b). Kikapcsolt Ortho esetén a végpont a szalkereszt helyére kertil.

14
© Phare PMU-94.05 0201-L015-03



1.3.5. Osnap

A targyraszter (Object Snap) segitségével a rajzelemek jellemzd pontjainak kijeldlését
végezhetjiik el. A funkcid a legordiilé meniibdl, a képernydmentiibdl vagy az egér kozépsd gombjara
(Ctr]l + jobb gomb) megjelend meniibdl érhetd el. Gyakran adédnak olyan helyzetek, amikor ez a
harom megoldés til nehézkesnek bizonyul. Ilyen példaul a méretezés miivelete, ahol legtobbszor
végpontokat és metszéspontokat jeldliink ki. Hogy ne kelljen minden egyes pontmegadas eldtt a
meniikbdl kivalasztani a megfeleld jellemz6t, a példanal maradva beallithatjuk ugy a kijeldlést,
hogy a program allandoan végpontokat és metszéspontokat keressen: Tools menii > Object Snap
Settings (5. abra). Mint az az abran is lathato, itt allithatjuk be azt is, hogy a szalkereszt milyen
nagysagu kornyezetében keresse a program a jellemzdé pontokat. (Ha nem talal ilyen pontot, a
széalkereszt poziciojat jeloli ki.)

Az alland6 pontfogast ki is kapcsolhatjuk. A ki- vagy bekapcsolt allapotot jelzi a statuszsor
OSNAP felirata. A kapcsolas F3-mal vagy egérrel torténhet.

A 14-es AutoCAD Ujdonsaga az, hogy a megtalalt jellemz6 pont szimbdluma megjelenik a
képernyon, a szalkereszt mellett. Ezek a szimbdlumok a kdvetkezdk:

Dsnap Settings HE I

L B | Autosnap(Th) |
— Select zetting

O W Endpaint 0 [ Ingertion

A W Midpaink b W Pempendicular
& W Center T ¥ Tangent

5 [ Mode 2 [ Mearest

<3 ¥ Quadiant B ™ apparent Int
W Interzection ™ Quick

Clear all |

—&perture size

L

&

QK I Catcel | Help |

5. abra
Az egyes pontok jelentése:
Endpoint: szakasz vagy iv végpontjanak megadasa
Midpoint: szakasz vagy iv felez6pontjdnak megadasa
Center: kor vagy iv kozéppontjanak megadasa (nem a kdzéppontra, hanem a rajzelemre kell
mutatnunk)
Node: csomopont megadasa

Quadrant: a kor kvadrans pontjainak megadésa (a kozépponttél 0, 90, 180 és 270°-ra 1évo
pontok a kordn, lasd 6. abra grip-pontjai)

Intersection: metszéspont megadasa

Insertion: blokk (lasd: Jegyzet, A Draw menii parancsai c. fejezet, Block almentii) beillesztési
pontjdnak megadéasa (nem a pontra, hanem a blokkra kell mutatnunk)

Perpendicular:akkor kell haszndlnunk, ha egy rajzelemre merdleges vonalat akarunk huzni. A
végpont kijelolésénél kell a targyrasztert alkalmazni.
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Tangent: az ¢l6zO6hoz hasonldéan végpont megadasanal hasznalatos, segitségével éErintot
hazhatunk.

Nearest: a szalkereszthez legkodzelebb es6 olyan pontot jeldli ki, amely egy rajzelemen van.

Apparent Int: Valojadban nem metsz6dé rajzelemek meghosszabbitasabol adodo, ,.latszolagos”
metszéspont kijelolése.

Quick: nem Onallo pontfogést tesz lehetdvé, hanem a jellemzd pontok megkeresésének
modjat befolyasolja.

A Running Object Snap 4altal megtalalt jellemz0 pontok kozt a Tab billentytvel
1épkedhetiink.

1.3.6. Model

A kapcsoloval a Modell Tér és a Papir Tér kozt valthatunk, az egér segitségével.

1.3.7. Tile

A Modell Tér megjelenitési modjat allitja be. A lehetdségek: Tiled (sz6 szerint csempézett, a
magyar verzioban Illeszkedd, a Tilemode valtozo értéke 1), Floating (Gszo, a magyar verzidban

Atfedd, a Tilemode valtozo értéke 0).

1.3.8. A funkciobillentyiik miikodése

F1 — DOS-os verzidkndl a karakteres képernyd (a parancssor) megjelenitése, windowsos
AutoCAD-nél a Sugd inditasa

F2 — windowsos verzidknal a parancssor ablakdnak megjelenitése

F3 — Object Snap be- és kikapcsolasa

F4 — a digitalizalo tabla be- ¢s kikapcsolasa

F5 — valtas a bal, a feliil- és a jobb oldalnézet kozt

F6 — a koordinatdk megjelenitésének be- és kikapcsolasa

F7 — a Grid racspontok megjelenitésének be- és kikapcsolasa

F8 — az Otrho be- ¢és kikapcsoldsa

F9 — a Snap be- ¢és kikapcsolasa

F10 - a statuszsor megjelenitésének be- és kikapcsolasa

F11 —szabadon definialhato
F12 —szabadon definialhato

1.4. OBJEKTUMOK KIJELOLESE

Az AutoCAD kijeldlési funkcidi lehetdvé teszik azt, hogy akar egy, akar tobb lépésben,
gyorsan valaszthassuk ki a modositani kivant rajzelemeinket. Ezt a kivalasztdst megtehetjiik az
érintett parancs alkalmazasa kozben, a [Select Objects:| vagy egy hasonld prompt
megjelenésekor, de a parancs kiadasa el6tt is, ha a Tools = Selection parancsra megjelené Object
Selection Settings ablakban bekapcsoltuk az eldvalasztast (Noun/Verb Selection).

A rajzelemek kivalasztdsa torténhet egyenként vagy azok ablakba foglalasaval. A
szalkereszt a kivalasztaskor eltiinik, helyét a kis kivalaszto négyzet foglalja el. Ezzel mutathatunk ra
a kijelolni kivant rajzelemekre. Ha iires teriiletre mutatunk, vagy a parancssorba fw| —t vagy —t
gépeliink, a kivalaszto ablak egyik sarkat jelolhetjiik ki. Ekkor megjelenik a szalkereszt és az ablak.
A kijelolés befejezéséhez az egérrel vagy billentylizettel meg kell adnunk az ablak masik, az elsdvel
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atlos sarkat. Az egér hizésa kozben alapértelmezettként nem kell a bal gombot nyomva tartanunk.
A kijeldlés szempontjabdl fontos a két, 4tlds pont relativ helyzete (6. dbra):

6. abra

Ha balrol jobbra haladva jeloljiik ki az ablak sarkait, akkor csak azok a rajzelemek kertilnek
kivalasztasra, amelyek teljes egészében a kijelolt ablakon beliil vannak. Ha jobbrol balra haladva
végezziik a kijelolést, az Osszes olyan rajzelemet kivalasztjuk, amelyek ,,beleérnek™ az ablakba,
azaz legalabb egy kis résziikk az ablakon beliil helyezkedik el. Az atlos sarkok fiiggdleges
elhelyezkedésének sorrendje nincs hatdssal a kijelolésre.

A kivalasztott elemeken megjelennek a grip-pontok, valamint az elemek szaggatotta valnak,
ahogy az az abran is lathatd. A szaggatott megjelenés beallitas kérdése (Tools > Drawing Aids,
Highlight opcio).

Az ablakos kijelolést persze csak olyan parancsoknal hasznéalhatjuk, amely parancsok tobb
rajzelem egyidejli kezelésére képesek. Majdnem minden parancs ilyen, de van egy-két kivétel, pl. a
Fillet, a Trim vagy az Object Properties eszkdztar Make Object’s Layer Current parancsa,
amelyeknél csak egy rajzelemet (vagy tobbet, egyesével) valaszthatunk ki.

A tobbi parancs esetében tobb 1épésben is végezhetiink kivalasztast: tobb ablakkal és
egyesével is, vegyesen.

Egyéb lehetdségek:

— A kivalasztas torlése bizonyos rajzelemekrdl. A funkcio két esetben lehet segitségiinkre: ha
véletleniil valasztottunk ki egy rajzelemet, vagy ha egy nagyobb teriilet Osszes rajzelemét ki
szeretnénk valasztani, egy-két kivétellel. A funkcié alkalmazasa: képernyé menii: ASSIST >
Remove.

— Ha toroltik a nem megfelel kivalasztasokat, Gjabb elemeket az ASSIST > Add meniipont
segitségével jelolhetiink ki.

— Az 6sszes rajzelemet az ASSIST - All meniiponttal valaszthatjuk ki.

— Az utoljara megrajzolt objektumot az ASSIST > Last segitségével jelolhetjik ki.
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— Az utolso kivalasztast az ASSIST - Previous meniiponttal ismételhetjiik meg.

— Téglalap alaku ablak helyett sokszdggel is kivalaszthatunk: ASSIST = CPolygon, Wpolygon,
Fence.

— Az ASSIST - Group meniipont a Group paranccsal csoportba foglalt rajzelemeket jel6li ki, a
csoport nevének megadasaval.

1.4.1. A megjelenités beallitasai

A szerkesztés soran kiilonbozé megjelenitési formakra van sziikségiink: megjelenithetiink
egy kis rajzrészletet a képernydre nagyitva, ezzel megkonnyitjiik a szerkesztését, de a teljes rajzot is
a képernyore helyezhetjiik. A megjelenités beallitasat végzo parancsok a View meniiben talalhatok.
Kétdimenzios szerkesztés esetén legtobbszor a View = Zoom almeniit hasznaljuk.

A bedllitds két 0 fajtdja a Zoom (nagyitas), illetve a Pan (kdvetés). A koztik 1évo
kiilonbséget a 7. abra mutatja:

Pan Zoom

-----------

...........

7. abra

A nagy, all6 téglalap a teljes rajzot, a vastag vonalu fekvd téglalap a jelenleg képernyén 1évo
rajzrészletet, a szaggatott vonali téglalapok a paranccsal megjelenithetd rajzrészleteket
szimbolizaljak.

A megjelenités részletes beallitasait lasd: Jegyzet: A View menii parancsai c. fejezet.

1.5. ELLENORZO KERDESEK

— Mi a kiilonbség a raszteres €s a vektoros képszerkesztés kozt?

— Hanyféleképp lehet az AutoCAD parancsait kiadni?

— Alapértelmezés szerint milyen funkciét 14t el a harom egérgomb?

— Kétgombos egér esetén hogyan lehet a k6zépsé egérgomb funkcidjat hasznalni?

— Hogyan kiilonbdzteti meg a program a parancssorban az alapértelmezett értékeket?
— Mi akiilonbség a WCS ¢és az UCS kozt?

— Mi az Ortho, a Snap funkcié Iényege?

— Hogyan hasznalhat6 a relativ koordinata-megadas?
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— MiaZoom ¢s a Pan funkcid szti kiilonbség? ] ;
2. UJ RAJZ KEZDESE, A RAJZ JELLEGENEK MEGFELELO
BEALLITASOK

2.1. A RAJZELEMEK JELLEMZOI

Geometriai jellemzdik mellett a rajzelemek harom {6 tulajdonsaggal rendelkeznek:

— vonaltipussal,
— szinnel,
— harmadik fontos jellemzdjiik az, hogy melyik rétegen (folidn) helyezkednek el.

Ezekhez tarsul még a vastagsag (Thickness), illetve a 14-es verzional a vonaltipus
skalazhatosaga (Ltscale), azaz nyujtasa. Ezek ismertetése a Jegyzetben megtalalhato.

Az 1 rajzelem az aktualis bedllitdisoknak megfelelden késziil el, azaz az aktualis vonaltipus,
szin, illetve réteg lesz ra jellemzd. Ezeket a beallitasokat legegyszeriibben az Object Properties
eszkoztar ikonjaival végezhetjiik el (8. dbra). Ugyanezzel az eszkoztarral modosithatjuk is a mar
megrajzolt rajzelemek tulajdonségait.

_Object Propertics

B
%l%l Il:;:' 4] % i-'D "-.-"astag j ||:| E}_lrlL.ayer

—  BylLayer j ﬁl

8. abra

Balrol jobbra haladva a nyomégombok funkcioi a kdvetkezok:

— Make Object’s Layer Current: megnyomasa utan egy rajzelemet kell kivalasztanunk. Ezzel a
rajzelem rétegét tettilkk aktudlissd. A rajzolast ezen a rétegen folytathatjuk. (Az ablakos
kivalasztas itt természetesen nem hasznalhato, mivel csak egy rajzelemet kell kijelolniink.)

— Layers: segitségével a Layer & Linetype Properties ablakot nyithatjuk meg ().

— Layer Control: a kijelolt objektumokat helyezi 4t masik rétegre. Ha nincsenek rajzelemek
kijelolve, akkor az aktiv réteget allitja be.

— Color Control: a kijeldlt objektumok szinét modositja. Ha nincsenek kijeldlt rajzelemek, akkor
az aktiv szint allitja be. Egy rajzelem szine lehet a 256 szinii skala valamely komponense, vagy
lehet logikai szin: a rajzelemre jellemz6 réteg szine (ByLayer) vagy a rajzelemet tartalmazé
blokk szine (ByBlock).

— Linetype: a Layer & Linetype Properties ablakot nyitja meg.

— Linetype Control: a kijelolt objektumok vonaltipusat modositja. Ha nincsenek rajzelemek
kijelolve, akkor az aktiv vonaltipust allitja be.

— Properties: a kijelolt rajzelemek tulajdonsagait modositja. A szinen, vonaltipuson és rétegen
kiviil modosithatjuk a geometriai jellemzoket is, pl. egy kor sugarat vagy kozéppontjat, egy
vonal végpontjainak helyét, de le is kérdezhetiink adatokat, pl. ivhosszt, emelkedési szdget,
keriiletet, teriiletet, stb. Tobb elem kijelolése esetén csak az 6t alaptulajdonsag modosithato.

DOS-os verzidknal a kdvetkezd parancsokra van sziikségiink: Linetype, Color, Layer.

Ezeket a jellemzOket utdlag is megvaltoztathatjuk, a Modify - Properties (Command:|
Chprop|) paranccsal, vagy az Object Properties eszkdztar megfeleld ikonjaival.
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2.1.1. Layer — a rétegek alkalmazasa

A Layer (Réteg) szot a magyar nyelvlii AutoCAD-ben Folid-val helyettesitették. Ez jol
kifejezi a rétegek szerepét: ugy miikdodnek, mint az irasvetiton egymadsra helyezett folidk. A
rajzteriiletrl ugyanugy ,,levehetd” az adott helyzetben felesleges rajzelemeket tartalmazo folia,
mint az irasvetitérol, ez jelentésen meggyorsitja a szerkesztést, és a gép munkajat is konnyiti.

A rétegek jellemzoi:

— Név: nevet szabadon valaszthatunk, de néhany dologra iigyelniink kell. Szokdézt nem
hasznalhatunk, helyette a _ jelet kell alkalmaznunk. DOS-0s AutoCAD esetében révid nevet
adjunk meg, és keriiljiik az ékezetes betlik hasznalatat. A rovid nevek hasznalata azért ajanlatos,
mert a DOS-o0s programnal parancssorbol is tudjuk kezelni a rétegeket, a neveket itt be kell
gépelniink. Ha rajzunkat egy olyan gépre vissziik at, amelyen a DOS alatt nincs beallitva a
magyar billentylizet-kiosztas, nem tudjuk haszndlni a rétegek neveit a parancssorban.
Windowsnal a beallitas hidnyanak kicsi a valoszintisége.

— Be- vagy kikapcsolt allapot (On/Off): a kikapcsolt réteg rajzelemei nem jelennek meg a
képernyon.

— Lefagyasztott vagy felolvasztott allapot (Freeze/Thaw): a lefagyasztott réteg sem jelenik meg
a képernyon. Szamitaskor a rendszer nem veszi figyelembe, tehat az opcié noveli a rendszer
sebességét.

— Lezart vagy nyitott allapot (Lock/Unlock): a zart réteg lathatd, de nem szerkeszthetd.

— Szin (Color): hasznaljuk az alapszineket!

— Vonaltipus (Linetype): hasznalhatunk szabvanyos ¢és sajat készitésli vonaltipusokat is.

2.1.2. Vonaltipusok alkalmazasa

Rajzainkban hasznalhatjuk a program altal felajanlott kész vonaltipusokat, de létrehozhatunk
sajat tipusokat is. A kiilonb6z6 verziok e tekintetben 1ényeges eltéréseket tartalmaznak. Az azonban
mindegyik verzio k6zos jellemzdje, hogy a vonaltipusokat egy vagy tobb féjlban tarolja (a fajlnevek
szintén kiilonbozoek), az ) vonaltipusokat is egy ilyen fajlba menti (alapértelmezett: acad.lin). (Ez
rendkiviil hasznos, mivel az daltalunk haszndlt egyedi vonaltipusokat egy madsik gépre is
atmasolhatjuk, nem kell 0jbdl létrehoznunk azokat.) Szintén kozos jellemzd, hogy a hasznalni
kivant vonaltipusokat be kell tolteniink az adott f4jlbol. Csak ezt kdvetden tudjuk azokat egy
réteghez vagy egy rajzelemhez rendelni.

2.1.3. Szinek alkalmazasa

Az AutoCAD — mas CAD programoktdl eltéréen — az egyszerli rajzelemekhez nem tud a
képernyOn vastagsagot tarsitani. (Ez csak polivonalak esetében lehetséges.) Ahhoz, hogy az eltérd
vastagsagu vonalakat meg tudjuk kiilonboztetni a monitoron, eltéré szinnel kell azokat
megjeleniteni. A kiillonb6z0 szinek alkalmazasa nem csak a vonalvastagsagok azonositasara szolgal,
hanem attekinthetdbbé is teheti a rajzot, pl. egy Osszedllitasi rajz egyes alkatrészeit kiilonb6zo
szinekkel is abrazolhatjuk. A szinek dontd fontossdga mégis a vonalvastagsagokhoz kotddik: a
nyomtatok ¢és plotterek a szinek alapjan nyomtatnak kiilonbozé vastagsagt vonalakat, tehat
semmiképp nem tudunk a kirajzoltataskor eltéré vastagsagui vonalakat azonos szinnel abrazolni (a
vonallancok — Polyline — alkalmazasatol eltekintve).

A szinek kivalasztasdnal a 256 szinl skalabol valogathatunk. A nyomtatds megkonnyitése
céljabol tanacsos az alapszinek alkalmazéséra szoritkozni.
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2.2. UJRAJZ KEZDESE, A FOBB BEALLITASOK

A rajzolas megkezdése el6tt el kell végezniink a rajznak megfeleld beallitasokat. A 14-es
AutoCAD New parancsa ezt jelentdsen megkOnnyiti, azonban sziikség lehet ezek utdlagos
modositasara is.

Az itt targyalt beallitasok csak az aktualis rajzra vannak hatassal.

2.2.1. Mértékegységek

A mértékegységek megadasanak formajat a Units paranccsal valtoztathatjuk.

2.2.2. Rajzhatarok

A rajzhatar az a teriilet, amelyre szandékaink szerint rajzolni fogunk. A Limits parancs
kiadasa utan két, atlés sarok megadasaval kell kijelolniink a rajzhatart. A View = Zoom > All
parancs ezt helyezi a képernydre. Rajzolhatunk a rajzhatdron kiviilre is, és modosithatjuk is a
rajzhatart.

2.2.3. Vonaltipusok létrehozasa

A mar emlitett acad.lin f4jl szolgél a vonaltipusok taroldséra. Ez egy szoveges allomany,
amely egyszerlien atszerkeszthetd. Ez a vonaltipusok l1étrehozasanak egyik modja.

A masik mddszer a —linetype parancs kiadasa (régebbi verziok: linetype). Ez abban tér el az
el6z6tdl, hogy itt helyettiink a program szerkeszti at az allomanyt. Nézzilk meg egy pontvonal
létrehozasanak 1épéseit! Legyen a vonal 10, a pont 2 mm hosszu, koztiik a tdvolsag 2 mm.

Command: -linetype
?/Create/Load/Set: c

Name of linetype to create: pv (Célszerti rovid nevet hasznalni.)

(Itt jelenik meg a Create or Append Linetype File ablak, amelyben egy 0j fajlnevet adtam meg.)
Creating new file

Descriptive text: pontvonal —----- - ———=—-— - ————- (Ez a szOveg barmi lehet.)
Enter pattern (on next line):
A,10,-2,2,-2 (Ez a vonaltipus leirasa.)

New definition written to file.

?/Create/Load/Set: 1 (Itt toltjiik be az 1) vonaltipust a Load opcioval.)
Linetype(s) to load: pv

Linetype PV loaded.

?/Create/Load/Set: (Ha mast nem akarunk beallitani, Enterrel 1éphetiink ki a parancsbol.)
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A vonaltipus leirdsanal pozitiv értékek megfeleld rajzegység hosszu vonalat, negativ értékek
vonal kihagyasat eredményezik.

A 13-as verziotol lehetdségiink van kiilonleges vonaltipusok 1étrehozasara is. (PL. egyetlen
Line paranccsal megrajzolhatunk egy reteszhornyot, de szovegeket is definidlhatunk a
vonaltipusokon beliil.)

2.2.4. Rétegek létrehozasa

Az Object Properties eszkoztar (8. abra) Layers gombjaval megnyithatjuk a Layer &
Linetype ablakot. Itt a New gombot kell valasztanunk, majd begépelni az 4j réteg nevét (pl. vékony,
vastag, sraffozas, méret, tételszam, stb.). Ezt kdvetden valtoztathatjuk meg a réteg szinét és
vonaltipusat, a réteg soraban a megfeleld ikonra kattintva (9. dbra). A rétegeket torolhetjiik is, a
Delete gombbal. (Korabbi verzioknal ez csak egy segédprogrammal lehetséges.)

Show: IAII j Current: | Wekany

Hame | Ell F| |

C. | Linetype I
O Contirnuous
O

Eontmuous Delete |

L.

3
o
=

9. abra

A Current nyomogombbal a kijelolt réteget tehetjiik aktualissd. Az Uj rajzelemek erre a
rétegre kertilnek.

A 0 réteg minden rajzban szerepel. Ez az AutoCAD altal hasznalt réteg.
2.2.5. A méretmegadas beallitasa

Az AutoCAD a megadott méreteket Onallo rajzelemekként kezeli, tehat nem kell
megrajzolnunk egyenként a segédvonalakat, a méretvonalat, a nyilakat és a méretszamot, ezeket a
program generalja a megadott pontoknak megfeleléen. Ehhez azonban meg kell adnunk azt, hogy
mekkordk legyenek a méretszamok, illetve a méretnyilak, mekkora legyen a segédvonalak
tulnytlasa a méretvonaltdl, milyen legyen a méretszam helyzete, stb. Ezeket a beallitasokat a
méretezd valtozok taroljadk. A valtoztatdsokat kétféleképp allithatjuk be. A legdrdiild meni
Dimension - Style parancsa grafikus segitséget is nyujt. Itt el is menthetjiik a beallitasokat egy
stilusba. A méretezési stilusokat a rajzon beliil tarolja a program. Masik lehetdség a bedllitasokra a
képerny6 menii DIMNSION -> Dimstyle parancsa. Ennek segitségével ki is listazhatjuk a
megadott stilus méretezd valtozoinak beallitasat:
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Command: dimstyle dimension style: PSZI

dimension style overrides:

DIMUPT

Dimension

Style

<Restore>: v

?/Enter dimension style name or press

pszi

Status of PSZI:

DIMALT Off
DIMALTD 4
DIMALTEF 0.0394
DIMALTTD 4
DIMALTTZ O
DIMALTU 8
DIMALTZ O
DIMAPOST

DIMASO On
DIMASZ 4.0000
DIMAUNIT O
DIMBLK

DIMBLK1

DIMBLK?2

DIMCEN 0.0000
DIMCLRD BYBLOCK
DIMCLRE BYBLOCK
DIMCLRT BYBLOCK
DIMDEC 4
Press ENTER to continue:
DIMDLE 0.0000
DIMDLI 7.0000
DIMEXE 1.2500
DIMEXO 0.0000
DIMFIT 3
DIMGAP 0.6250
DIMJUST 0

line

DIMLFAC 1.0000
DIMLIM Off
DIMPOST

DIMRND 0.0000
DIMSAH Off
DIMSCALE 0.0000
DIMSD1 Off
DIMSD?2 Off
DIMSE1 Off
DIMSE?2 Off
DIMSHO On
DIMSOXD Off
DIMSTYLE PSZI

Alternate
Alternate
Alternate
Alternate
Alternate
Alternate
Alternate

(Save/Restore/STatus/Variables/RApply/?)

ENTER to select dimension:

units selected

unit decimal places

unit scale factor
tolerance decimal places
tolerance zero suppression
units

unit zero suppression

Prefix and suffix for alternate text

Create ass
Arrow size
Angular un
Arrow bloc
First arro
Second arr
Center mar
Dimension
Extension
Dimension
Decimal pl

Dimension
Dimension
Extension
Extension
Fit text

ociative dimensions

it format

k name

w block name

ow block name

k size

line and leader color
line color

text color

aces

line extension

line spacing

above dimension line
line origin offset

Gap from dimension line to text
Justification of text on dimension

Linear uni

t scale factor

Generate dimension limits
Prefix and suffix for dimension text
Rounding wvalue

Separate a
Overall sc
Suppress t
Suppress t
Suppress t
Suppress t

rrow blocks
ale factor
he first dimension line
he second dimension line
he first extension line
he second extension line

Update dimensions while dragging

Suppress o
Current di

utside dimension lines
mension style (read-only)
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DIMTAD

Press ENTER to continue:

1

Place text above the dimension line

DIMTDEC 4 Tolerance decimal places

DIMTFAC 1.0000 Tolerance text height scaling factor
DIMTIH Off Text inside extensions is horizontal
DIMTIX Off Place text inside extensions

DIMTM 0.0000 Minus tolerance

DIMTOFL On Force line inside extension lines
DIMTOH Off Text outside horizontal

DIMTOL Ooff Tolerance dimensioning

DIMTOLJ 1 Tolerance vertical justification
DIMTP 0.0000 Plus tolerance

DIMTSZ 0.0000 Tick size

DIMTVP 0.0000 Text vertical position

DIMTXSTY STANDARD Text style

DIMTXT 3.5000 Text height

DIMTZIN O Tolerance zero suppression

DIMUNIT 8 Unit format

DIMUPT Off User positioned text

DIMZIN 8 Zero suppression

Az egyes méretekre vonatkozd beallitasokat utolag is modosithatjuk.

2.2.6. A rajzelemek megjelenitésének beallitasai

A CAD programok memoriaigényes szoftverek. A rajz vagy modell bonyolultsdga

figgvényében nd a kezeléséhez sziikséges memoria mérete is.

A miveletek sebessége

crer

hatranya, hogy — az elavult operacids rendszer fogyatékossdga miatt — csak 64 MB-nyi memoriat
tudnak kezelni. Windows NT, esetleg 95 alatt ez a korlat megsziinik.

A sebesség ingyen is ndvelhetd, bizonyos beallitasok elvégzésével:

— a Solid Fill kikapcsolasaval,
— a Quick Text bekapcsoldsaval.

A Solid Fill kikapcsolasaval a kitoltott elemeket (pl. a sraffozdsokat vagy a nyilhegyeket)
iiresen abrazolhatjuk. A Quick text opcioval a szovegek megjelenitését egyszertsithetjiik le: csak a
szoveg befoglald téglalapja jelenik meg a képernyén. Mindkét opcié a Tools = Drawing Aids
paranccsal el6hivott parbeszédablakban allithatd. (Az ablak részletes ismertetését lasd: Jegyzet, A
Tools menii parancsai c. fejezet, Drawing Aids.) Bedllitasuk utdn sziikséges a Regen parancs
kiadasa.

Még egy fontos beallitast kell megemliteniink: ez a Blipmode vagy Blips. Szintén a Drawing
Aids ablakban kapcsolhatd be vagy ki. Bekapcsolt allapotdban a program minden egyes
pontmegadas helyére kis keresztet rajzol. Ezek nem részei a rajznak, csupan a képernyon jelennek
meg, Redraw vagy Regen paranccsal eltlintethetOk. Ha zavaronak talaljuk ezeket a kereszteket,
kapcsoljuk ki a Blips opciot.
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2.3. UJRAJZ KEZDESE, A SABLON VAGY PROTOTIPUS FAJLOK
HASZNALATA

A rajzolas elkezdése elott 1étre kell hoznunk a megfeleld rétegeket, illetve be kell télteniink
(vagy el kell készitenlink) a hasznalni kivant vonaltipusokat, esetleg meniiket, méretezési ¢és
betlistilusokat, koordinatarendszereket, stb., azaz be kell allitanunk az adott rajz jellegének
megfeleld kornyezetet. Ez ahhoz tal 6sszetett feladat, hogy minden rajz kezdése elétt elvégezziik.
Ettdl kimélnek meg minket a sablon fajlok vagy ahogy régebbi verzidknal nevezték Oket: a
prototipus fajlok.

A régebbi verzidkban barmelyik rajzunkat felhasznélhatjuk prototipus fajlként, mivel ezen
verziok prototipus fajljai ugyanolyan, DWG kiterjesztésii rajzallomanyok, mint a munkaink.
A kiilonbség az, hogy a prototipus fajlok — mivel egy ,iires rajzlap” szerepét toltik be, nem
tartalmaznak rajzelemeket (vagy csak allandé rajzelemeket tartalmaznak, pl. keretet, szovegmezot,
stb.). Viszont tartalmazzak a rajzra vonatkozé Osszes bedllitast. Elkészitésiik igen egyszerii: egy Uj
rajzot kezdve létrehozzuk az allanddan hasznélni kivant rétegeket, vonaltipusokat, beallitjuk a
méretezés valtozoit (errdl késébb lesz szd), a koordinatarendszert, stb. Megrajzolhatjuk az 4lland6
rajzelemeket is. Ha végeztiink, elmentjiik a rajzot. A prototipus fajlokat a program Support
alkdnyvtaraban tarolja és keresi, tehat célszerli ide menteni az 4llomanyt. Amikor egy Uj rajzot
kezdiink, a New parancsra megjelend ablakban ki tudjuk valasztani a megfeleld prototipus f3jlt.

A 14-es AutoCAD ezeket a fijlokat mar Template-eknek (sablonoknak) nevezi, és a
program Template alkOnyvtaraban tarolja. Létrehozdsukndl ugyanaz az eljards, mint az el6zd
verzioknal, de a Save Drawing As ablak alsé részén fajltipusként a Drawing Template File-t kell
kivéalasztanunk. A program automatikusan a Template alkonyvtérat ajanlja fel a mentés helyeként, a
fajl DWT kiterjesztést kap.

Nyilvéan lesznek hasonl6 jellegii rajzaink. Ilyen, hasonld rajzokat Osszefoglald kategoriak
lehetnek a gépészeti mithelyrajzok, Osszedllitdsi rajzok, elektromos kapcsolasok rajzai, grafikak,
folyamatabrak, stb. Ezeknek a kategoriaknak célszerti kiilon-kiilon létrehozni a megfeleld sablon
fajlt.

24. ANEW PARANCS

A File menii New parancsaval kezdhetlink 0j rajzot. Mivel a program egyszerre még csak
egy rajzot tud kezelni, a New parancs magaval vonja a jelenleg szerkesztett rajz bezarasat. Ha ez
megtortént, a Create New Drawing ablak lehetdségei koziil valaszthatunk:

— Use a Wizard (elvégezziik a mértékegységek, a szogmegadas, a rajzteriilet és a keret beallitasat,
ezeket kés6bb modosithatjuk),

— Use a Template (kész sablonféjllal kezdiink rajzolni),

— Start From Scratch (csak a hasznalni kivant mértékegység-rendszert valasztjuk ki).

Az opciok részletes leirasat lasd: Jegyzet, File menii parancsai fejezet, New.

A régebbi verziokban csak a prototipus fajlt kell kivalasztanunk (amennyiben hasznalni
kivanjuk a lehetdséget).
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2.5. ELLENORZO KERDESEK

— Hogyan kezdhet 4j rajzot?

— Uj rajz kezdésekor milyen lehetdségek koziil valaszthat a 14-es verzioban?

— Hogyan allithatja be a rajzelemek harom 6 jellemzdjét: a szint, vonaltipust és réteget?
— Mik azok a logikai szinek és vonaltipusok?

— Hogyan allithatja be a rajzhatarokat?

—  Miért célszerii rétegeket alkalmazni?

3. ELSO RAJZGYAKORLAT: OSSZETETT SIKIDOMOK SZERKESZTESE

3.1. LEIRAS

A sikbeli szerkesztést kiilonbozé tomitések megrajzolasaval kezdjiik. A gyakorlat soran
elsajatitott fobb ismeretek:

— vonalak, korok és ellipszisek huzésa,
— arétegek alkalmazésa,

— rajzelemek vagasa,

— apontfogés hasznalata,

— parhuzamos vonalak huizasa,

— tiikr6zés alkalmazasa,

— rajzelemek kiosztasa.

Az elso tomités mihelyrajzat a 10. dbra mutatja:

R\
/

_

o4
B30
|
i
\

|
|
21
260

S

/
\

/0,9

!

10. abra

A méretezést egy késébbi rajzgyakorlatban fogjuk eldszor alkalmazni, most csak a vastag €s
a kozépvonalakat rajzoljuk meg. Ezeket kiilon rétegre tegyiik, tehat elsé 1épésként — amennyiben
sablon f4jl alkalmazasa nélkiil kezdtiik a rajzolast — hozzunk létre egy réteget a vastag vonalak, és
egy masikat a kozépvonalak szamara (Object Properties eszkoztar - Layers, New). A rétegek
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neve legyen: Vastag, Kozep. Rendeljiik hozza a Kézep réteghez a korabban mar létrehozott
pontvonalat (lasd: Uj rajz kezdése, a fobb beallitasok, Vonaltipusok létrehozasa c. fejezet). Adjunk
meg eltérd szint a rétegek szamara. Kapcsoljuk be a Snap és az Ortho funkciot.

Jeloljik ki aktualissa a Kozép réteget (Object Properties eszkoztar = Layer Control).
Jelenitsiik meg a 0,0 és a 200,100 pontok kozti teriiletet (View = Zoom > Window). Hliizzuk meg
a vizszintes kézépvonalat (Draw > Line). A kezdépont a képernyd bal szélén, a rajzteriilet
magassaganak kb. a felénél legyen. (A vonal vizszintes, és a hossza 120 mm, kapcsoljuk be az
Ortho funkciét, valamint a relativ koordinatdk megjelenitését.) A fiiggdleges kozépvonal
meghtzédsa utdn kovetkezhet a két kivagas kozépvonaldnak megrajzoldsa. Ezt tobbféleképp
végezhetjik. Az egyik modszer szerint a kozépsé fliggdleges pontvonal parhuzamos maésolatait
huzzuk meg, adott tavolsagra: Draw = Offset:

Command: offset

Offset distance or Through <Through>: 35.25 A tavolsag megadésa
Select object to offset: Jeloljiik ki a fliggéleges pontvonalat!
Side to offset? Mutassunk a vonal bal oldalara!
Select object to offset: Jeloljiik ki ismét a vonalat!
Side to offset? Mutassunk a vonal jobb oldalara!
Select object to offset: Lépjlink ki a parancsbol!

Ezzel megrajzoltuk az 6sszes kozépvonalat. Valtsunk at a Vastag rétegre!

Rajzoljuk meg a négy kort! (Hat teljes kort rajzolunk, ezek koziil harmat még modositanunk
kell.) A rajzolast a Draw = Circle paranccsal végezziik:

Command: circle 3P/2P/TTR/<Center point>: int of
Diameter/<Radius>: d
Diameter: 60

A kozéppontokat a metszéspontok megfogasaval adjuk meg (kozépsé6 gomb >
Intersection). Az atmér6 megadasdhoz gépeljiink be d-t, vagy valasszuk a képernyd menii
Diameter meniipontjat. Ehhez hasonldéan hozzuk létre a tobbi kort is. (Az azonos atmérdjlicket
célszeri egymast kovetden megrajzolnunk, mert a program megjegyzi az utolsdé adatot, amit
begépelés helyett jobb egérgombbal vagy Enterrel elfogadhatunk.)

Huzzuk meg az abran lathaté ferde vonalat (11. dbra)! A konnyebb szamolas érdekében
helyezziikk az origbt a kozépsé kor kozéppontjaba: Tools = UCS -> Origin. Hasznaljuk a
pontfogast! Ezutan kovetkezik a Draw = Line parancs. A kezdépont koordinatai 0,27, a végpontot
az Object Snap menii (koz&psé gomb) Tangent (Erintd) meniipontjaval jeldljiik ki. Valasszuk ki a
meniipontot, majd mutassunk a jobb oldali korre! Az eredmény az dbran lathato érintd:
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11. abra

Tiikrozziik ezt a vonalat a vizszintes pontvonalra: Modify = Mirror:

Command: mirror

Select objects: 1 found Valasszuk ki a ferde vonalat!
Select objects: Jobb gombbal fejezziik be a kivalasztast!
First point of mirror line: endp of Second point: Jeloljiik ki a

tilkortengely két pontjat!
Delete old objects? <N> Az eredeti rajzelemet nem akarjuk tor6lni.

Az eredeti €s a tliikrozott ferde vonalat tiikrozziik a fiiggdleges kozépvonalra!

Kovetkezhet a felesleges vonalrészek eltiintetése. Ezt a Modify - Trim paranccsal
végezziik:

Command: trim
Select cutting edges: (Projmode = UCS, Edgemode = No extend)
Select objects: w A vagoéleket jeloljiik ki ablakkal, a 12. dbra szerint.

First corner: Other corner: 6 found

Select objects: Jobb gombbal fejezziik be a kijeldlést!
<Select object to trim>/Project/Edge/Undo: Mutassunk r4 a felesleges
<Select object to trim>/Project/Edge/Undo: vonalrészekre!

<Select object to trim>/Project/Edge/Undo:

Jobb gombbal fejezhetjiik be a parancsot.
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12. abra

A parancs elvégzése soran lathatd, hogy a kijelolt vagdélek ,eltintetésiik utan is
miikodnek™, azaz ha magat a vagoélt is levagjuk, a tovabbi rajzelemek moédositdsdra még mindig
hatéassal van.

Az el6z6hoz hasonldan rajzoljuk meg a kovetkezd tomitést:
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13. abra
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A méretmegadastol egyeldre itt is tekintsiink el.

Kezdjiink egy 10j rajzot (File 2 New), majd ellen6rizziik az Ortho és a Snap bekapcsolt
allapotat! A rajzot a két kozépvonal megrajzolasaval kezdjiik (Object Properties eszkoztar —>
Layer Control, Draw - Line). Ha ez megvan, kovetkezhet a két ellipszis. A kisebb (Draw =>
Ellipse > Center):

Command: ellipse

Arc/Center/<Axis endpoint 1>: e

Center of ellipse: _int of Jeloljiik ki a pontvonalak metszéspontjat!
Axis endpoint: Adjuk meg az ellipszis és a vizszintes pontvonal egyik metszéspontjat!
<Other axis distance>/Rotation: Adjuk meg az ellipszis és a fiiggdleges pontvonal

egyik metszéspontjat!
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A pontokat konnyebben megadhatjuk, ha F6-tal atkapcsolunk a relativ koordinatak
megjelenitésére. Az Ellipse parancs részletes ismertetése a Jegyzet A Draw menii parancsai c.
fejezetében olvashato.

A masodik ellipszist megrajzolhatjuk az els6héz hasonldan, de valaszthatjuk a Modify menii
Offset parancsat is:

Command: offset

Offset distance or Through <Through>: 6.5 Adjuk meg a tavolsagot!
Select object to offset: Valasszuk ki az ellipszist!
Side to offset? Mutassunk az ellipszisen kiviil esd tertiletre!
Select object to offset: Lépjiink ki a parancsbol!

Ezt kovetéen két szerkesztdvonalat huzunk, az & 7-es Ilyuk kozéppontjanak
meghatarozasahoz. Ezt azért célszerli most elvégezni, mert az utolsé parancsot (Offset) a jobb
egérgombbal ismételhet;jiik:

Command:

OFFSET

Offset distance or Through <6.5000>: 24.5 Adjuk meg az 0 tavolsagot!
Select object to offset: Valasszuk ki a fliggbleges kdzépvonalat!
Side to offset? Mutassunk a vonal jobb oldaléra!
Select object to offset: Ismét jeloljiik ki az eredeti pontvonalat!
Side to offset? Mutassunk a bal oldalra!
Select object to offset: Lépjlink ki a parancsbol!

Rajzoljuk meg a két kort (& 7, R 6,5) a jobb oldali fiiggdleges pontvonal és a nagyobb
ellipszis felsd metszéspontjaba (Draw eszkoztar = Circle)! Az eddig elkésziilt rajzot a 14. abra
mutatja:

14. abra

A masik hat kort tobbféleképp is megrajzolhatjuk: az egyik modszer szerint a két kort
tiikkrozhetjiik az egyik szimmetria-tengelyre, majd a négy kort a masikra. A masik modszerrel egy
1épésben rajzolhatjuk meg az Osszes kort. Ez a kiosztassal (Modify = Array) torténik. (A parancs
részletes ismertetése a Jegyzetben talalhato).
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Kiosztasnal kétféle lehetdség koziil valaszthatunk:

— polaris kiosztas: egy pont koriil sokszorozzuk meg a kijeldlt rajzelemeket (ilyen pl. az osztokori
furatok vagy egy lanckerék fogainak megrajzolasa),

— rektangularis kiosztas: sorok és oszlopok metszéspontjaira méasolhatjuk a rajzelemeket (ilyen pl.
egy perforalt lemez furatainak megrajzolasa).

Neklink itt az utdbbira lesz sziikséglink:

Command: array
Select objects: 2 found Jeloljiik ki a két kort!

Select objects:

Rectangular or Polar array (<R>/P): Valasszuk a téglalapos kiosztést!
Number of rows (---) <1>: 2 Adjuk meg a sorok szamat!
Number of columns (| |]) <1>: 2 Adjuk meg az oszlopok szamat!
Unit cell or distance between rows (---): Other corner: A réacspontok

kozti téglalap megadasa a szerint.

Nt L T

\% | N
_ _ 1 _D _ _ 1
| |

15. abra

A korok megjelenése utan toroljiik ki a feleslegessé valt két fliggdleges pontvonalat!

Vagjuk le a felesleges vonalakat (Modify = Trim)! Vagoélként a nagyobb koroket és a
nagyobb ellipszist kell megadnunk, ezt kdvetden ra kell mutatnunk a nagyobb kordk ellipszisen
beliil eso, €s az ellipszis korokon beliili részeire.

Huzzuk meg a Kozép rétegen a lyukak szimmetria-vonalait! Rajzoljuk meg ujra a kiilsé
ellipszist, ehhez hasznaljuk a metszéspontok megfogasat! Rajzoljunk egy 5 mm sugaru, az & 7-es
lyukkal koncentrikus kort! Hizzunk egy vonalat az ellipszisre €s a korre merdlegesen! Vagjuk le az
elébb megrajzolt ellipszis €s vonal felesleges részeit az R 5-0s korrel, majd toréljik a kort! A
miiveletet a 16. dbra mutatja:
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16. abra

Tiikr6zziik az ivet és a vonalat a szimmetria-tengelyekre (Modify = Mirror)! A méretek
megadasat egy késobbi gyakorlatban fogjuk elvégezni.

3.2. ELLENORZO KERDESEK

— Mely parancsokkal huizhat vonalat, kort, illetve ellipszist?
— Mi a pontfogas 1ényege?

— Hogyan tud tobb objektumot egy 1épésben kivalasztani?

— Hogyan lehet meglévo objektumokkal parhuzamost htuzni?
— Hogyan tud rajzelemeket tiikrozni?

32
© Phare PMU-94.05 0201-L015-03



4. MASODIK RAJZGYAKORLAT: LANCKEREK MEGRAJZOLASA

4.1. LEIRAS

A gyakorlat soran elsajatitott fébb ismeretek:

— rajzelemek polaris kiosztasa,
— ivek huzasa.

A kész rajzot az 17. dbra mutatja:
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17. abra

A New parancs utan szokas szerint kezdjiik a rajzot a kdzépvonalak megrajzolasaval (Layer
Control: Kozép, Draw - Line)! A pontos koordinataknak itt sincs jelentésége, viszont ne
felejtsiik el bekapcsolni az Ortho és a Snap funkcidt! Megfelelé hossziisagu vonalak érdekében
kapcsoljunk 4t a relativ koordinata-megjelenitésre (F6)!

Helyezziik a teljes rajzot a képernydre: View = Zoom > Extents.
Rajzoljuk meg az J 55-6s osztokort (Draw > Circle, d), majd valtsunk vissza a Vastag

rétegre, és jobb gombbal ismételve a Circle parancsot, rajzoljuk meg az & 30-as tengelyfuratot a
kozépvonalak metszéspontjaba!l
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A reteszhorony megrajzolasa el6tt helyezziik at az origbt a 18. abra 5. pontjaba: Tools >
UCS = Origin. Ez lehetdvé teszi azt, hogy ne kelljen fejben szamolnunk a horony koordinatait.
Huzzuk meg a harom vonalat az abra szerint (az x-szel jelolt koordinatdkat nem kell figyelniink a
rajzolas kozben, az Ortho funkci6 bekapcsolt allapota esetén):

3| 2

3, % {x, 32.5)
4. 1
\ . ) (3.
|
4
5.

18. abra
Kovetkezhet a felesleges vonalak eltintetése (Modify = Trim). Ezt egy 1épésben is
elvégezhetjiik: vagoélként jeloljik ki a kort és a két fiiggdleges vonalat, majd jobb gombot
kovetben mutassunk ra a korre a két vonal kozt, valamint a vonalak alsé felére!

Rajzoljunk egy teljes, R 4-es kort a fiiggdleges kdzépvonal és az osztokor metszéspontjaba

(Draw - Circle), majd vagjuk le az osztokoron kiviil es6 részét (Modify = Trim)!

4.2. POLARIS KIOSZTAS ALKALMAZASA

Korabban — a masodik tomités lyukainak megrajzolasakor — mar volt sz6 a kiosztast végzo
Array parancsrol. Az opciok koziil akkor a rektanguldris kiosztast valasztottuk, itt a polarisra lesz
sziikségiink. Osszuk ki az eldbb megrajzolt R 4-es korivet a kozéppont koriil, 15-szor:

Command: array

Select objects: 1 found Jeloljiik ki a korivet!
Select objects: Tobb elemet is kijelolhetnénk, ezért le kell zarnunk a kivalasztast.
Rectangular or Polar array (<R>/P): p Vélasszuk a polaris kiosztast!

Base/<Specify center point of array>: Adjuk meg a pontvonalak metszéspontjat!
Number of items: 15 Az eredeti rajzelemmel egyiitt 15 fogat kell rajzolnunk.
Angle to fill (+=ccw, -=cw) <360>: A kiosztds szoge, fontos a pozitiv forgasirany

Rotate objects as they are copied? <Y> A rajzelemeket el kell forgatni a kiosztas
soran.

Ezt koveten két kort rajzolunk (Draw => Circle) az R 4-es ivek kozéppontjaba. Sugarérték
szamszerii megadasa helyett a szomszédos iv megfeleld végpontjat jeloljiik ki, a 19. 4bra szerint:
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19. abra

Rajzoljuk meg az & 60-as kort (Draw = Circle, d), majd tiintessiik el a kis korok és a kiilso
kor felesleges részeit (Modify = Trim)! Vagoélnek adjuk meg a két kis kort, az osztokort és az &
60-as kort! Ha megfeleld sorrendben mutatunk a vdgandé részekre, akkor a kdvetkezd dbra szerinti
eredményhez jutunk:

20. abra

Az Array paranccsal az ismert moédon osszuk ki a fog 0sztokoron kiviil es§ harom vonalat!

4.3. ELLENORZO KERDESEK

— Ismertesse a téglalapos €s a polaris kiosztas miiveletét!
— Osszon ki egy négyzetet polarisan, elforgatassal és elforgatas nélkiil!
— Hogyan tudja az UCS origdjat athelyezni, és miért célszerli ezt alkalmazni?
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5. HARMADIK RAJZGYAKORLAT: KOZPONTFURAT, GYAKRAN
SZEREPLO RAJZRESZLETEK KEZELESE

5.1. LEIRAS
A gyakorlat soran elsajatitott fébb ismeretek:

— apolarkoordinatarendszer kezelése,
— szabadkézi vonalak huizasa,

— vonalak meghosszabbitésa,

— ablokkok célszert kialakitasa,

— akoordinata-megadas sziirése.

A rajzot a 21. dbra mutatja. Az 4bra jobb oldalén lathato a ténylegesen elkészitett rajz:

- .
s A—-1—-—a &
L
]
< |
#1’3=
21. abra

Az itt szerepld kozpontfurat egy olyan rajzrészlet, amely szamos munkdnkban el6éfordul.
Az ilyen részleteket az AutoCAD-ben elég egyszer megrajzolnunk, majd a késébbi munkainkba
beilleszteniink. A késdbbiekben az is ki fog deriilni, hogy miért pont az & 1mm-es furatot rajzoljuk
meg.

Kezdjiink egy 1j rajzot! Nagyitsuk a képernydre a (-5, -5) és az (5, 5) pontok kozti teriiletet
(View = Zoom = Window)! Kis méretii rajzrol 1évén sz6, modosithatjuk a Snap értékét is.

Huzzunk az origébdl egy 1 mm hosszl és 60°-os emelkedésti vonalat (Draw > Line): a
kezddpont megadasa utan a végpont polarkoordinatait adjuk meg: . (A hossz értéke nem
lényeges a rajz szempontjabol, mivel pontos értéket nem tudunk megadni. Ha a vonal tal hosszu,
akkor a Modify = Trim paranccsal vagjuk, ha tal rovid, akkor a Modify = Extend paranccsal
meghosszabbitjuk azt egy masik rajzelemig.) Lépjiink ki a parancsbol, majd jobb gombbal
ismételjiik azt: huzzunk egy vizszintes vonalat az (x, 0.5) pontbol az (1.3, 0.5) pontba, innen pedig
polarkoordinatakkal rajzoljunk egy 3 mm hosszua és 30°-0s emelkedésii vonalat: . Meg kell
még huznunk a harom, fiiggéleges athatast, és a rovid vizszintes vonalat, ahogy azt a 22. dbra is
mutatja (az x-ek itt is azokat a koordinatékat helyettesitik, amelyeknek nincs jelentdsége.

36
© Phare PMU-94.05 0201-L015-03



(@3<30)

(@1<60) ‘ (x, 1.08)
/

{x, 0.5) .

A ‘ (1.3, 0.5)
0,0

22. abra

Vagjuk le az abran jelolt felesleges vonalrészeket (Modify = Trim), toroljik a rovid,
vizszintes vonalat (Modify = Erase), majd tiikr6zziik a rajzot (Modify = Mirror)!

5.2. SZABADKEZI VONALAK HUZASA

Hatra van még a kitdrés megrajzolasa. Kapcsoljuk ki az Ortho funkcidt, és irjuk be a

parancssorba: [Sketch:

Command: sketch
Record increment <1.0000>: O Nagyobb érték durvabb vonalat eredményez.

Sketch. Pen eXit Quit Record Erase Connect . <Pen down> <Pen up>
390 lines recorded. Bal gombbal tehetjiik le és emelhetjiik fel a tollat.

A Sketch parancs sok apro, egyenes vonalbol allitja 6ssze a gorbét. Ezen vonalak hosszat
allitja be a record increment értéke. A parancs a lezarasakor kozli a megrajzolt apr6 vonalak szamat.

A parancs kiaddsa utdn a bal egérgombbal ,le kell engedniink a tollat a papirra”, majd
végightiznunk az egeret a rajzolni kivant vonal mentén. Ha a végére értliink, emeljiik fel a tollat a
bal gombbal, ¢s 1épjiink ki a parancsbol. A vonalat a 23. dbra szerint htizzuk (1., 2. pont):

2.
23. abra
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Mivel a szabadkézi vonal sok, apré szegmenséhez sok jellemzd adat tartozik, észrevehetden
megnovekszik a rajzfajl mérete. Ezért a késObbiekben ajanlott a kitoréseket egy specidlis, Osszetett
vonaltipus segitségével dbrazolni. Az dsszetett vonaltipusok elkészitésérdl a Jegyzetben esik sz6.

5.3. RAJZELEMEK MEGHOSSZABBITASA

Rajzelemeket az Modify = Extend paranccsal hosszabbithatunk meg. A parancs hasonldéan
miikodik a Modify = Trim-hez. Az eltérés az, hogy itt nem a vagéélt kell megadnunk, hanem azt a
rajzelemet, amelyhez meg akarunk hosszabbitani mas vonalakat vagy iveket. Abban is hasonl6 a
Trim-hez, hogy egy 1épésben tobb elemet is meghosszabbithatunk: hosszabbitsuk meg a 23. abra 2.
pontjaban végz6do vonalat is:

Command: extend
Select boundary edges: (Projmode = UCS, Edgemode = No extend)

Select objects: 1 found Vilasszuk ki az elsd hatarvonalat (23. dbra, 3. pont)!
Select objects: 1 found Valasszuk ki a masodikat, alul!
Select objects: Fejezziik be a kivalasztast!

<Select object to extend>/Project/Edge/Undo: Mutassunk a 23. bra 4. pontjara!
<Select object to extend>/Project/Edge/Undo:  Mutassunk a masik vonalra is!
<Select object to extend>/Project/Edge/Undo: Lépjiink ki a parancsbol!

A [Select object to extendl promptndl arra kell figyelniink, hogy a
meghosszabbitand6 rajzelem kijelolésekor a rajzelemnek a hatdrvonalhoz kozelebb esd felére
mutassunk, a program csak ebben az esetben tudja azt meghosszabbitani.

Amennyiben a Sketch paranccsal rajzolt szabadkézi vonal els6 vagy utolsé (esetleg mindkét)
szegmense fiiggdleges, akkor ezeket természetesen nem tudjuk meghosszabbitani a veliik
parhuzamos hatarvonalig. Ebben az esetben toroljik ezeket, és az el6ttik allo szegmenseket
hosszabbitsuk meg.

Az Extend parancs részletes ismertetését lasd: Jegyzet: A Modify menii parancsai c. fejezet.

5.4. BLOKKOK CELSZERU KIALAKITASA

Ha végeztiink a meghosszabbitassal, kitorolhetjiilk az elébb hatarvonalként haszndlt két
fliggdleges vonalat. Azért nincs sziikség ezekre a vonalakra és a kdzépvonalra sem, mert ezek mar
szerepelni fognak a rajzon, amelybe a kdzpontfuratot beszarjuk. Ez az egyik olyan dolog, amelyre
figyelmet kell forditanunk blokkok elkészitésekor.

A masik fontos dolog a bazispont elhelyezése. A blokkok beszurasaval a kdvetkezo
rajzgyakorlatban foglalkozunk. El6ljaroban annyit kell megjegyezniink: a blokkok helyzetét a
rajzban beszlraskor egy bazisponttal hatarozzuk meg. A blokk készitése soran olyan bazispontot
kell megadnunk, amely a késObbiekben egyszertien haszndlhatd: mar szerepel a rajzon, valamely
rajzelem jellemzd pontjaként. A mi esetiinkben adott egy tengely és a tengelyvonal. Ezen a rajzon
kézenfekvd, hogy a legkonnyebben megadhatd pont a tengelyvonal és a tengely homlokfeliiletének
metszéspontja.
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Tovébbi tudnivald, hogy blokkokat definialhatunk egy rajzon beliil (14sd: Jegyzet: A Draw
menil parancsai, Block almenii), illetve a blokkokhoz hasonléan beszirhatunk teljes rajzokat is. Mi
ezt fogjuk alkalmazni a kézpontfurat beszlrdsanal.

Ebben az esetben az AutoCAD bazispontként az adott rajz (a kdozpontfurat) origojat tekinti
bazispontnak, ennek a pontnak a helyét kell megadnunk a tengelyrajzon.

Ha az origotol eltérd bazispontot akarunk definialni, akkor a parancsot kell
alkalmaznunk:

Command: base
Base point <0.0000,0.0000,0.0000>: Meg kell adnunk a bazispont koordinatait.

A kozpontfurat rajzan a homlokfeliilet és a tengelyvonal metszéspontja a 23. dbra 5.
pontjaban van. Tetszés szerint a Tools = UCS - Origin vagy a base parancs alkalmazasaval ezt a
pontot kell megadnunk a rajz befejezéseként.

5.5. A KOORDINATA-MEGADAS SZURESE

Ez a pont azonban ,,10g a levegdben”, rdadasul szemre, a szalkereszttel vald vetitéssel sem
tudjuk kijelolni, mivel nem esik egybe vizszintes ¢és fliggdleges vonalakkal, illetve a Grid
racspontjaival. Az X koordinatdja viszont egybeesik a 120°-os ktp csticsaval (23. abra, 6. pont), az
Y koordinatdja pedig a 60°-os kup alkotdjanak végpontjaval (23. 4bra, 7. pont). Az 5. pontot tehat
meg tudjuk adni a koordinatdk sziirésével, ami azt jelenti, hogy egérrel két 1épésben adjuk meg a
koordinatakat. Ezt a kozépsé gombra eldugré Object Snap menii Point Filters almeniijével
végezziik. A rendelkezésre allo6 meniipontok:

.X: az egérrel kijelolt pont koordinatai koziil a program csak az X koordinatat veszi figyelembe,
a pont Y koordinatajat a kdvetkezd egérkijelolés adja meg (be is gépelhetjiik az értéket).

— .Y:csak az Y koordinatat veszi figyelembe.

— .Z: csak a Z koordinatat veszi figyelembe.

- XY,

- XZ,

— .YZ: a haromdimenzids szerkesztés lehetdségei.

A parancs tehat: Base vagy pedig Tools - UCS -> Origin, aszerint, hogy csak a
bazispontot vagy az origét is a 23. abra 5. pontjaba kivanjuk helyezni. Azért, hogy a miivelet
eredménye azonnal lathatd legyen, valasszuk az utdbbit:

Command: ucs
Origin/ZAxis/3point/OBject/View/X/Y/Z/Prev/Restore/Save/Del/?/<Wor
1d>: o

Origin point <0,0,0>: .Y of endp of (need XZ): endp of

Adjuk ki a parancsot, majd valasszuk az Object Snap = Point Filters = .Y meniipontot!
Itt kovetkezhet a végpont megfogasa: Object Snap = Endpoint, ezt kovetden mutassunk ra a 23.
abra 6. pontjara! Ismét végpontot jellink ki: Object Snap -> Endpoint, most a 7. pontra
mutassunk! A parancs befejezddik, az origd az 5. pontban van. Ez a procedura kissé
koriilményesnek tlinhet, kis gyakorlas utan azonban hatékonyan hasznalhato.
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Ellendrizziik a bazispont helyzetét (Base), és ha nem az origdban van, helyezziik oda, majd
mentsiik el a rajzot! A blokkjaink szdméara tanacsos egy kiilon kdnyvtarat 1étrehozni.

5.6. ELLENORZO KERDESEK

— Hogyan tud rajzelemeket mas rajzelemek segitségével meghosszabbitani, illetve vagni?
— Miért nem sraffoztuk be a kdzpontfurat kitdrését?

— Hogyan tud adott sz6gli vonalakat htizni?

— Mire kell ligyelni szabadkézi vonallal végzett vagaskor, illetve meghosszabbitaskor?

— Mi a lényege a koordinata-megadas szlirésének?
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6. NEGYEDIK RAJZGYAKORLAT: LEPCSOS TENGELY
MUHELYRAJZA

6.1. LEIRAS
A gyakorlat soran elsajatitott fébb ismeretek:

a Légi Nézet hasznalata,
zart teriiletek sraffozasa,
lekerekités, letorés rajzolasa,
rajzelemek nyujtasa,
blokkok beszurasa.

A kész rajzot a 24. dbra mutatja:
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Az eddigi feladatoktol eltérd, viszonylag nagy méreti rajzok megkezdésekor tanacsos
beallitani a rajzhatarokat (Format = Drawing Limits). A parancs kiadasa utan a rajzlap két, atlos
sarkat kell meghataroznunk. Az igy befoglalt téglalap lesz a rajzlapunk. Ez nem azt jelenti, hogy a
téglalapon kiviilre nem tudunk rajzolni, a beallitdsnak csupan a View = Zoom -> All parancsra
van hatdsa: a parancs a Drawing Limits segitségével meghatarozott teriiletet helyezi a képernydre.
A rajzhatdrokat barmikor moédosithatjuk. Most allitsuk be a (0, 0) és a (420, 297) pontok kozé
(Format - Drawing Limits), majd nagyitsuk a képernyére (View = Zoom > All)!

Valtsunk at a Kozép rétegre, és htizzuk meg a tengelyvonalat (Draw -> Line), nagyjabol a
képernyd magassaganak felénél, a rajzteriilet fliggdleges sz¢léig.

A fejszamoléasok elkeriilhetdk, ha a rajz készitése soran mindig a megfeleld pontra
helyezziik az origot. A pont megvalasztasa a rajz méreteinek bazisatdl fiigg. Lathato, hogy a 90;
93,8; 99,5; stb. méretek a tengely bal homlokfeliiletétél vannak megadva. A pontmegadasok soran
célszerli lenne, ha ezek egyben X koordinata-értékek is lennének, kdvetkezésképp az origd X iranyu
helyzete legyen a bal homlokfeliilet! A tengely masik jellemzd méretcsoportja az atmérdkbdl all. A
szerkesztés soran sugarértékekkel kell dolgoznunk. Ezek akkor esnek egybe az UCS szerinti Y
koordinatakkal, ha az origd a tengelyvonalon van. Az UCS origdjat tehat a tengelyvonal és a bal
homlokfeliilet metszéspontjaba kell tenniink. Adjuk ki a Tools = UCS => Origin parancsot, majd
az Object snap meniibdl (kozépsé gomb) valasszuk ki a Nearest meniipontot. Ez a szalkereszthez
legekozelebb eso, rajzelemen 1€évo pontot fogja meg. Mutassunk a szalkereszttel a pontvonal bal
oldali végétdl kb. 10 - 15 mm-re!

6.2. A LEGINEZET HASZNALATA

Az egérrel torténd pontmegadés jelentdsen megkonnyithetd, ha mindig csak a sziikséges
rajzrészletet helyezziik a képernyoére, azaz a lehetd legnagyobb forméban jelenitjilk meg a rajzot. A
szalkereszt rajzegységnyi elmozduldsahoz igy nagyobb egérelmozdulds tartozik. Rajzelemek
kijelolésekor is sziikség lehet nagyitasra, itt pl. a tengely vallainak meghosszabbitasakor. Egyes
vallaknal a kicsi atmérdkiilonbség miatt olyan rovidek a vonalak, hogy a kivélaszté négyzetbe
egyszerre tobb rajzelem is beleesik, igy bizonytalanna valik a kijeldlés.

A Légi Nézet (Aerial View) egy kiilon ablak, melynek célja a nagyitasok (Zoom) és
vonszolasok (Pan) dinamikus elvégzése, kiilon parancs kiaddsa nélkiil, barmilyen rajzparancs
miikodése kdzben. Az ablakban lathaté a rajzunk kicsinyitett képe. Ezen jeldlhetiink ki két pontot
(Zoom), vagy mozgathatunk egy fekete keretet (Pan). A funkcidk altal meghatarozott teriilet
(Zoom: a két pont kozti téglalap, Pan: a fekete keret) lesz lathat6 a képerny0 rajzteriiletén. A Zoom
¢s Pan funkci6 kozt az eszkoztar ikonjaival vagy az egér jobb gombjaval valthatunk. A Légi Nézet
részletes ismertetését lasd: Jegyzet, A View menii parancsai c. fejezet.

Ellendrizziik az Ortho és a Snap bekapcsolt allapotat (F8, F9), és allitsuk a Snap értékét
0.25-re! Kapcsoljuk be a Légi Nézet ablakat (View = Aerial View)! Valtsunk at a Vastag rétegre,
és adjuk ki a Draw - Line parancsot! A kezdSpontot adjuk meg begépeléssel: [0, 0] A letdrésektd]
¢és lekerekitésektdl tekintsiink el, a kovetkezd pontok koordinatai tehat: (0,17.5), (23,17.5), ...,
(127.5, 27). Ha allandé pontfogasokat is bedllitottunk (Running Object Snap), azokat az F3
funkciobillentytivel kapcsolhatjuk ki, a konnyebb pontmegadéas érdekében. A beszuras 1.7 H12
méretének megrajzolasakor hasznaljuk a relativ koordinata-megadast! A vonalak rajzolasa kdzben
hasznaljuk ki az Aerial View funkcioit! A rajz a kovetkezd abran lathato:
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25. abra

Ne felejtsiik el, hogy a szalkeresztet billentytizettel is mozgathatjuk (Ctrl + kurzornyilak). A
mozgatas 1épéskoze a Ctrl + Page Up, Ctrl + Page Down billentylizet-kombinacidkkal
szabalyozhat6. A pontot Enterrel adhatjuk meg.

Ha idaig eljutottunk, helyezziik at az origét a jelenlegi UCS (379, 0) pontjaba (Tools 2>
UCS - Origin), a tengely masik végére!

Ismét vonalakat hizunk (Draw - Line) az el6z6ekhez hasonléan. A pontok koordinatai: (0,
0); (0, 17.5); (25, 17.5); (-25, 19.5), ..., (-128, 27). Az utolsé pontot adjuk meg pontfogassal
(Object Snap > Endpoint)!

6.3. LEKEREKITES, LETORES RAJZOLASA

A lekerekitéseket a Modify > Fillet, a letoréseket a Modify = Chamfer paranccsal
végezhetjiik. Lekerekités esetén a koriv sugarat. letdrés esetén a toréspontoknak a két vonal
metszéspontjatol mért tavolsagat kell megadnunk. Fontos, hogy a vonalak megadasa is ennek
megfeleld legyen. A vonalak vagésa (azaz a torésvonalon, illetve koriven tal esé részek eltliintetése)
opcionalis. A két vonal megadasa soran mindig a megmaradé részekre kell mutatnunk. A 13-as
verziotdl lehetdségiink van parhuzamos vonalak lekerekitésére is. A Fillet és Chamfer parancsok
részletes ismertetése a Jegyzet: A Modify menii parancsai c. fejezetében talalhato.

Kerekitsiik le a tengely két, sz¢éls6 vallat (a parancs kozben hasznalhatjuk az Aerial View
ablakot):

Command: fillet

(TRIM mode) Current fillet radius = 0.0000

Polyline/Radius/Trim/<Select first object>: r

Enter fillet radius <0.0000>: 0.5 Allitsuk be a lekerekités sugarat!
Ha a program kilép a parancsbol, jobb gombbal ismételhetjiik.

Command:

FILLET

(TRIM mode) Current fillet radius = 0.5000

Polyline/Radius/Trim/<Select first object>: Valasszuk kia 25. dbra 1. pontjat!

Select second object: Valasszuk ki a 25. abra 2. pontjat!

Ismételjiik meg a parancsot a masik harom lekerekités 1étrehozéasara!
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Torjiik le a tengely é€leit a megadott helyeken:

Command: chamfer

(TRIM mode) Current chamfer Distl = 0.0000, Dist2 = 0.0000

Polyline/Distance/Angle/Trim/Method/<Select first line>: d

Enter first chamfer distance <0.0000>: 1 Az elso tavolsag megadasa.

Enter second chamfer distance <1.0000>: A masodik tavolsag alapértelmezettként
megegyezik az els6vel (45°-os letdrést eredményezve).

Command: Ismételjiik a parancsot!

CHAMFER

(TRIM mode) Current chamfer Distl = 1.0000, Dist2 = 1.0000 Valasszuk

ki a 25. abra 3. pontjat!
Polyline/Distance/Angle/Trim/Method/<Select first line>:
Select second line: Valasszuk ki a 25. abra 4. pontjat!

Ismételjiik a parancsot a masik harom letorés 1étrehozasara!

A letorések soran uj athatasok keletkeztek a kiipos és hengeres feliiletek kozt. Rajzoljuk meg
ezeket a tengelyvonalig (Draw > Line)! Hasznaljuk a pontfogast (Object Snap): mind a négy
vonal esetében a kezddpont metszéspontbol indul (Intersection), és merdlegest htzunk a
pontvonalra (Perpendicular).

Ha ezzel végeztiink, hosszabbitsuk meg a vallak vonalait a koézépvonalig (Modify —>
Extend)! Osszesen tiz ilyen vonal van a rajzon. A miivelet egy parancskiadassal elvégezhetd, mert
a hatarvonal minden esetben a tengely kdzépvonala. Ugyeljiink arra, hogy a meghosszabbitando
rajzelemeket a hatarvonalhoz kodzelebb eso feliikon jeldljiik ki.

A reteszhornyokat sokféleképp megrajzolhatjuk. Probaljuk ki a kdvetkezé modszert:
Huzzunk harom vonalat, a kovetkezo koordinatak szerint:
(-100,0); (-100,7); (-124,7); (-124,0). (12-es AutoCAD esetén a két fliggdleges vonalnak tul kell

nyulnia a pontvonalon. A tilnyulé részeket késébb tordlni kell.)

Kerekitsiik le a két metszéspontot 7-es sugarral (Modify = Trim), a sugarat megadhatjuk a
végpontok kijelolésével is. Az eredményt a kovetkez6 abra mutatja:

N

5.

26. abra

Tegyiik at az origot a tengely masik végpontjaba (Tools = UCS > Origin)! Masoljuk at az
elobb megrajzolt iveket és vonalat a masik retesz helyére (Modify = Copy)! A bazispont legyen a
jobb oldali koriv és a kozépvonal metszéspontja (a 26. abra 5. pontja), a masodik pont pedig:
(123.5, 0).
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6.4. RAJZELEMEK NYUJTASA

A masodik retesz hossza nem egyezik meg az elséével, ezért ezt ,,0ssze kell nyomni” a
megfeleld méretre. Ezt legegyszeriibben a Modify = Stretch paranccsal tudjuk elvégezni.

A parancs alkalmazasa soran téglalapba foglalva valasztjuk ki a nyujtani kivant
rajzelemeket. Ezt kdvetéen — hasonléan a mozgatdshoz és a masoldshoz — egy vektort kell
megadnunk, a végpontjai segitségével. A vektor kezdOpontjat itt is bazispontnak, a végpontjat pedig
masodik pontnak nevezziik. A kijelolés modjatdl fiiggden a parancs mas-mas eredményt produkal.
A rajzelemek nyujtasa soran azok a jellemz6 pontok mozdulnak el, amelyek a kivalaszto ablakon
beliil estek. Esetiinkben a helyes kivalasztas a kovetkezd:

27. abra

Bazispontként adjuk meg a bal oldali koriv és a pontvonal metszéspontjat, masodik pontként
ennek 0j helyét kell kijeldlniink: [103, 0].

A reteszeket megrajzolhatjuk specidlis vonaltipus segitségével is, a mddszer ismertetése a
Jegyzetben megtalalhato.

Tiikr6zziik a tengely vonalait a pontvonalra (Modify = Mirror)! A rajzelemeket ablak
segitségével is kijelolhetjiik, de kiprobalhatjuk a kdvetkezé modszert is:

Command: mirror

Select objects: all Kijelolhetjiik az dsszes rajzelemet.
42 found

Select objects: remove Atkapcsolunk a kiejlolések visszavonasara.
Remove objects: 1 found, 1 removed Mutassunk a pontvonalra!
Remove objects: Jobb gombbal zarjuk le a kivalasztast!
First point of mirror line: Second point: Jeloljiik ki a tengelyvonalat!
Delete old objects? <N> Az eredeti rajzelemeket nem toroljiik.

6.5. BLOKKOK BESZURASA

A kozpontfuratok beszurasahoz adjuk ki az Insert = Block parancsot! A megjelend
parbeszédablakban két fo lehetdség koziil valaszthatunk:

— Dbeszurhatunk az aktualis rajzunkon beliil definialt blokkot,
— 1illetve teljes rajzot (f3jlt).
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Nekiink az utobbira lesz sziikséglink. Nyomjuk le a File gombot, és a megjelend
parbeszédablak segitségével mutassunk a kozpontfuratot tartalmazo dllomanyra (az elérési utat és a
fajlnevet begépeléssel is megadhatjuk). Ha ez megtortént, a Specify Parameters on Screen opcioval
eldonthetjiik, hogy az ablak als6 részén vagy a parancssorban kivanjuk meghatarozni a beszuras
jellemzdit:

— abeszurasi pontot (Insertion Point),
— anagyitasi tényezdt (Scale),
— az elforgatast (Rotation).

Esetiinkben az utobbi modszer (a parancssorbol torténd megadas) a célravezetd. Pipaljuk ki
a blokk szétrobbantasat végzo opciot (Explode)! Ez azt eredményezi, hogy a blokk egyes
rajzelemeire esik szét a beszurds sordn. (Erre azért van sziikség, mert vagoélként akarjuk
felhasznalni a kitorés szabadkézi vonalat.) OK gombra a parbeszédablak eltiinik. Ekkor meg kell
adnunk a harom jellemzd6t:

Command: ddinsert
Tnitializing... DDINSERT loaded.
Insertion point: Beszarasi pontként adjuk meg a tengely jobb homlokfeliiletének
¢s a tengelyvonalnak a metszéspontjat!
X scale factor <1> / Corner / XYZ: 2 Nagyitsuk kétszeresére az eredeti furatot!
Y scale factor (default=X): Lehetdségiink van torzitasra is.
Rotation angle <0>: Az elforgatas szogének megadasa.

A miveletben segit minket a blokk dinamikusan megjelenitett el6zetes képe.

Nyilvanval6, hogy az el6z6 rajzgyakorlatban azért valasztottuk az & 1 mm-es
kozpontfuratot, hogy a rajzba beszurt furat &tmérds mérete megegyezzen a beszuraskor megadott
skalaértékkel.

Szurjuk be a masik furatot is (ligyeljliink az elforgatds szogére), majd vagjuk le a tengely
¢lletoréseibol keletkezett fliggbleges athatasok felesleges részeit (Modify = Trim)! Ne felejtsiik el,
hogy a szabadkézi vonal apré szegmensekbdl all: a vagoéleket ablakkal kell kijeldlniink:

1.
— 1
.y
L5 —
~— ] 4
3.

28. abra

Hatra van még a szelvények megrajzoldsa. El0szor ezek fiiggdleges, majd vizszintes
kozépvonalait fogjuk meghtzni, két mddszer kiprobalasaval.
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Valtsunk at a kozépvonalak rétegére (Object Smap -> Layer Control), és htzzunk
fliggdleges vonalat az egyik reteszhorony vizszintes élének felezépontjabol (Midpoint) felfelé!
Valasszuk ki a vonalat, majd a megjelend Grip-pontok koziil az alsét, és huzzuk azt fiiggdlegesen
felfelé!

A masik vonalat megrajzolhatjuk a koordinatak sziirésével (Object Snap = Point Filters).
A kezdbépont X koordinatdja egybeesik a reteszhorony vizszintes élenek felez6pontjaval, az Y
koordinatat ,,szemre” adjuk meg. Ugyeljiink arra, hogy elegend6 helyet hagyjunk a méreteknek.

Huzzuk meg a vizszintes pontvonalakat is, majd valtsunk at a vékony vonalak rétegére.

Kezdjikk a rajzolast az J 48-as szelvénnyel, a lanckerék rajzanal ismertetett modon.
Rajzoljuk meg a kort a kdzépvonalak metszéspontjaba (Draw = Circle, d)! Tegyiik at az origét a
vizszintes pontvonal és a kor metszéspontjai koziil a jobb oldaliba (Tools - UCS -> Origin)!
Huzzuk meg a harom vonalat (Draw -> Line), és vagjuk le a felesleges részeket (Modify >
Trim)!

A masik szelvény megrajzolasa utan kovetkezhet a sraffozas.

6.6. ZART TERULETEK SRAFFOZASA

Ezt a miiveletet a Draw = Hatch paranccsal végezziik. A parancsot — az Insert = Block
parancshoz hasonldan — egy parbeszédablak segitségével tudjuk miikddtetni. Az ablak — munkéankat
megkonnyitendd — a kijelolések idejére eltiinik, majd Gjra megjelenik.

A sraffozas lényege a kovetkezd: az egérrel a besraffozni kivant zart teriiletek belsejébe
mutatunk (Pick Points), kivélasztjuk a sraffozas mintdjat (Pattern), beallitjuk a minta stirliségét
(Scale) ¢és elforgatasat (Angle), valamint az esetleges egyéb opcidkat, majd megtekintjiik a miivelet
varhaté eredményét (Preview Hatch). Ha sziikséges, valtoztathatunk a beallitasokon, majd ismételt
megtekintés utan elfogadjuk a ,,miivet” (Apply).

A 14-es AutoCAD tjdonsdga a tomor kitoltés. A korabbi verziokndl ez a feladat alacsony
skalaértékkel végzett ferde sraffozassal volt megoldhato. Tul stirti sraffozast azonban ekkor se
készitslink, mert plotteres kirajzoltatds esetén a tus megfolyhat.

Mintdul valasszuk a 45°-os vonalakat (ANSI31), a skalaérték legyen 0.25! Probaljuk ki a
Preview funkciot is! A sraffozési teriiletek megadéasakor (Pick Points) tandcsos a képernyodre
nagyitani a megfeleld rajzrészletet. A program a megtalalt teriileteket szaggatott vonallal jelzi. Ha
nem zart teriiletbe mutattunk, egy hibaiizenet jelenik meg. Ebben az esetben nagyitsuk ki ugy a
rajzot, hogy a tertilet teljes egészében a képernydn legyen! Ha az ismételt probalkozas is sikertelen,
megprobalhatjuk a rajzelemek kivalasztdsaval meghatarozni a teriiletet (Select Objects), vagy a
parancsbol kilépve zartta tehetjiik azt a rajzelemek modositasaval.

Sraffozzuk be a szelvényeket is, a minta skéalaértékét allitsuk 1-re!

6.7. ELLENORZO KERDESEK

— Hogyan tud blokkokat, illetve rajzokat beszlrni az aktualis rajzba?
— Mi a Légi Nézet eldnye a tobbi nagyitd paranccsal szemben?
— Hogyan tud rajzelemeket nyQjtani? Mire kell iigyelni a rajzelemek kivalasztasakor?
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7. OTODIK RAJZGYAKORLAT: MERETEK MEGADASA

7.1. LEIRAS

A gyakorlat sordn elsajatitott fobb ismeretek:

— kiilonb6z6 tipust méretek megadasa,
— améretmegadasok modositasa,
— rajzelemek megszakitésa.

A gyakorlat 6nallo rajzfeladatot nem tartalmaz. A feladat az eddig elkészitett rajzok
beméretezése. A feladatot a 1épcsdstengely rajzaval kezdjiik.

7.2. A MERETMEGADAS

Mint ahogy arr6l mar volt sz6, a CAD programok hasznélatakor nem kell egyenként
megrajzolnunk a segéd- és méretvonalakat, a nyilakat, valamint a méretszdmokat. Ehelyett ki kell
valasztanunk, hogy milyen jellegli méretet akarunk megadni (pl. hosszt vagy lekerekitést), eszerint
adjuk ki a méretnek fajtdjanak megfeleld parancsot. Ezt kovetden a méret jellemzd pontjait kell
kijeldlniink (pl. hosszméretnél a méret két végpontjat), majd a megadott méret elhelyezkedését kell
beallitanunk (hosszméretnél a méretvonal helyét jeloljiik ki), esetleg a méretszam helyét kell
meghataroznunk. Minden mast (pl. a nyilak elhelyezését) a program végez, ezért ezt félautomatikus
méretezésnek nevezziik. Azt, hogy a méretvonal végére milyen nyilat rajzoljon, milyen magas
legyen a méretszam, stb., a korabban mar emlitett méretezd valtozok értékeibdl donti el. Ezek
részletes beallitasait a Jegyzet tartalmazza. Az alabbi dbrdk a kiilonbozd jellegli méretek megadasa
soran kijelolt pontokat abrazoljak.

7.2.1. Hosszméretek megadasa

Dimension 2 Linear, Dimension 2 Baseline, Dimension = Continue:

I R 11K - AT
N
1.4
7.
2. 4.
5.
- E>’3 - :19
.3 90 -
- 93,8 -

- 103 ____20)5__:
- 127.5 -
29. abra
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Adjuk ki a Dimension > Linear parancsot, ¢s az abra szerint rajzoljuk meg a 23 mm-es
méretet:

— Adjuk meg az elsd segédvonal kezdépontjat: 29. ébra, 1. pont.

— Adjuk meg a masodik segédvonal kezddpontjat: 29. dbra, 2. pont.

— Adjuk meg a méretvonal helyét: 29. 4bra, 3. pont. Bedllitastol fiiggéen ez a pont hatarozhatja
meg a méretszam elhelyezkedését, a méretvonallal parhuzamos iranyban.

A tobbi méretet megrajzolhatjuk a Dimension = Baseline paranccsal. A parancs miikddése
a 14-es verzi6 esetén a kovetkezo:

— Ki kell jeldlniink a bazisfeliiletet prezentald segédvonalat. Ha a parancsot megelézden lineéris
méretet adtunk meg, akkor erre nincs sziikség: ezen méret elsd vonala lesz a bazis. Ezt a
megoldast dbrazolja a 29. ébra is.

— Ki kell jelolniink a méret masik végpontjat. A méretvonal elhelyezkedését a program hatarozza
meg az el6z0 méretvonal és a DIMDLI véltozo fliggvényében.

A Dimension > Continue parancs hasonldoan milkodik, az eltérés az, hogy itt
folytatdlagosan adhatunk meg méretet, pl. a 29. abra 20,5 mm-es méretét.

Adjuk meg a 29. abra Osszes méretét, a 379 mm-es méretet is. Ugyanezt az eljarast
ismételjiik meg a tengely masik végén, és adjuk meg a fiiggdleges atmérds méreteket is! Utobbiak
kozil az @ 40, az D 54 és az D 39-es méretek segédvonalai nem latszanak. Ezeket utolag
kikapcsolhatjuk, a Méretmegadasok modositasa c. alfejezetben leirtak szerint.

Beallitastol fliggden a program nem mindig kérdez ra a méretszdmra, hanem felirja a mért
érteket. Az & jeleket ebben az esetben utdlagos modositassal tudjuk elhelyezni a rajzon (lasd:
Meéretmegadasok modositasa, Specialis karakterek).

7.2.2. Atméré és sugar megadasa

Dimension = Radius, Dimension = Diameter:

K,
N[

30. abra

A 30. abra az atmérés méretek megadasat mutatja. A sugarak beméretezése is hasonlo
moddon torténik, a program ekkor természetesen a kor sugarat méri meg, a méretszam elé pedig R
kertil.
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7.2.3. Mutatovonal alkalmazasa

Dimension = Leader:

+

2
31. abra

A parancs alkalmazasa sordn a program nem mér semmilyen méretet. Elséként azt a pontot
kell megadni, ahova a nyilhegy mutat, a masodik ponttal a szoveg helyét hatarozhatjuk meg, végiil
begépelhetjiik a szoveget, amely tobbsoros is lehet.

Adjuk meg a rajzon szerepld lekerekitéseket!

7.2.4. Szog megadasa

Dimension > Angular:

32. abra

Ki kell vélasztanunk a szoget meghataroz6 két rajzelemet, majd azt, hogy a négy megadhat6
sz0g koziil melyiket kivanjuk abrazolni. Ezt kdveti a méretvonal, illetve méretszam elhelyezése.

7.2.5. Tiirések megadasa
A rajzon szerepl6 két helyzettiirést a Dimension = Tolerance paranccsal adhatjuk meg. A
parancs kiad4sara megjelend Symbol parbeszédablakbol valasszuk ki az egytengelyliség jelét, majd

a Geometric Tolerance ablakban adjuk meg az egyéb opcidkat:

— aTolerance 1 mezd Value ablakéba irjuk be a tiirés értékét: 0,05 ,
— aDatum 1 mez6é Datum ablakaba gépeljiik be: AB !

Az OK gomb megnyomadsat kvetden adjuk meg a tlirés helyét a rajzon, majd rajzoljuk meg
a nyilat (Dimension = Leader) a tliréstdl a feliiletig!

Rajzoljuk meg az A és a B bazis jelét!
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7.2.6. Specialis karakterek a méretszamokban

A billentylizet-kiosztdson nem szerepld, specidlis karakterek a kovetkezd helyettesitd
karaktersorozatokkal rajzolhatok meg, barmilyen AutoCAD szdvegben:

— atméro: %%c

- fok: %%d

— plusz/minusz: %%0p

- ,,sz0veg” aldhtizésa: %%u szoveg %%u
- ,,szoveg” feliilhuzasa: %%0 szoveg %%0
— aprogram altal mért méret: <>

Minden specialis karakter két % jellel és egy betiivel helyettesithetd. Szoveg ala- illetve
feliilhuzasanal meg kell adni a vonal kezdetét és végét is. A <> jel méretmegadaskor az AutoCAD
altal megmért tényleges tavolsdg. A méret nyuUjtdsaval mindig az aktudlis érték keriil a
méretvonalra.

7.3. MERETMEGADASOK MODOSITASA

Mar volt sz6 arrdl, hogy a méreteket a megfelelé méretezo valtozok értékei alapjan generalja
a program. Barmely méret valtozoit utdlag is at tudjuk allitani, tehat valtoztatasok esetén nem
szilkséges Ujra megrajzolnunk a méretet. A méret valtozoinak beallitdsat a kovetkezoképp
ellendrizhetjiik:

— Kiadjuk a Dimstyle parancsot a parancssorbol, majd a lehetdségek koziil kivalasztjuk a
Variables-t (v).

— Entert {itve a kivalaszto négyzettel rdmutatunk a megfelel6 méretre. Ezzel kapunk egy listat a
méret Osszes valtozdjanak aktualis beallitasarol.

Egy valtozo atallitasahoz gépeljiik be annak nevét, és Enter utan adjuk meg az 1j értéket.
Adjuk ki a Dimension = Update parancsot, majd mutassunk ra a megvaltoztatni kivant méretre
(méret alatt a segédvonalak, a méretvonal, a méretnyilak és a méretszam altal alkotott egyetlen
rajzelemet kell érteni.) A parancs elvégzi a méret Ujrageneralasit az aktudlis beéllitasoknak
megfelelden. Az 1) méretek ezeknek a beallitdisoknak megfelelden késziilnek el, tehat az atallitott
valtozokat a neviik begépelésével vissza kell allitanunk.

Viltoztassuk meg az J 40, az J 48, az O 54, az & 45 és az I 39-es méreteket:

— toroljik a segédvonalakat,
— irjuk ki az & jeleket!
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A segédvonalak torlése:

Command: dimsel
New value for DIMSEl <Off>: on Kapcsoljuk be az elsd,
Command: dimse?2

New value for DIMSE2 <Off>: on  ésamasodik segédvonal torlését végzo valtozokat!

Command:
Command:
Command: dimstyle dimension style: PSZI Adjuk ki a Dimension - Update
dimension style overrides: parancsot!

DIMDLT 7.0000

DIMEXO 0.0000

DIMSCALE 1.0000

DIMSE1 On

DIMSE?2 On

DIMUPT On
Dimension Style Edit (Save/Restore/STatus/Variables/Apply/?)
<Restore>: apply
Select objects: 1 found

Select objects: 1 found Jeloljiik ki a harom modositani kivant méretet!
Select objects: 1 found
Select objects: Jobb gombbal zarjuk a kivalasztast és egyben a parancsot is.

Command: dimsel

New value for DIMSEl <On>: off

Allitsuk vissza a valtozok értékeit!
Command: dimse?

New value for DIMSE2 <On>: off

A méretszam modositasa (az O jelek irasa, modositanunk kell a 42.5, és a 45.5 mm-es
atmérok megadasat is) a Dimedit paranccsal torténik (Dimension eszkdztar, parancssor):

Command: dimedit Dimension Edit (Home/New/Rotate/Oblique) <Home>:
n Uj méretszamot irunk, tehat valasszuk a new opciot!
Select objects: 1 found

Jeloljiik ki a hét, modositani kivant méretet!

Select objects: 1 found

Select objects: A megjelend parbeszédablakban modositsuk a méretszamot
<> 16l %%c<> -ra
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Hasonl6é modon javitsuk ki a 35 mm-es atmérok méretszamait <> -rdl %%c<>k6 -ra, az 1.7
mme-es beszirasok méretét <> H12-re, a letorésekét pedig <>x45%%d —re!

7.4. RAJZELEMEK MEGSZAKITASA

Lathatd, hogy a szimmetriatengely méretszamokat keresztez. Mivel ez rajztechnikailag
hibas, tordlniink kell a felesleges vonalrészeket. Erre is tobb modszer all rendelkezéstinkre.

7.4.1. A Break parancs

A parancs a Modify meniiben talalhato, a korabbi verzidkban sajat almeniivel. Segitségével
egy rajzelemet szakithatunk meg: két pontot kell kijeldlniink az objektumon, a pontok kozti rész
eltiinik.

Kor vagy ellipszis megszakitdsakor nem kozombos a pontok megadasdnak sorrendje: a
torlés a pozitiv (az 6ramutat6 jarasaval ellentétes) forgdsirdnyban torténik.

Ha a masodik pont helyett @-t gépeliink a parancssorba, a megadott rajzelem az adott
ponton kettévalik. Kor és ellipszis esetében ez az opcid nem hasznalhato.

7.4.2. Megszakitas a Trim parancs segitségével

Rajzolunk egy megfelelé nagysagu téglalapot (Draw -> Rectangle) az egyik méretszam
koré, majd masoljuk a megfelelé helyekre (Modify = Copy, Multiple)! Adjuk ki a Trim
parancsot, vagoélnek jeloljik ki az Osszes téglalapot, majd mutassunk a vagandd vonalak a
téglalapokon beliill esd részeire! A parancs végeztével torOlhetjiik a téglalapokat. A moddszer jol
hasznalhat6 olyan esetekben, ahol elég egy vagy két ideiglenes vagdélt megrajzolnunk, majd
tordlniink, ezen alkalmazasa azonban a sok téglalap miatt koriilményes.

Szakitsuk meg a tengely vonalait az J 45,5 és az & 42,5 mm-es méretek nyilainal!

7.5. BEALLITASOK A MERETMEGADAS MEGKONNYITESERE

7.5.1. A pontok megadasa

Az abrék alapjan lathaté, hogy a méretmegadds soran leggyakrabban végpontokat
(Endpoint) és metszéspontokat (Intersection) adunk meg. Kovetkezésképp ezeket tanacsos beallitani
az alland6 pontfogas ablakaban (Tools = Object Snap Settings, 5. abra).

A sraffozasok eltiintetése is megkonnyitheti a pontok megadésat: igy biztosan nem a 45°-0s
vonalak végpontjait fogjuk meg. Az eltlintetést kétféleképp végezhetjiik:

— ha a sraffozasok kiilon rétegen kaptak helyet, akkor a réteg lefagyasztasaval,
— a l4-es verzio FILLMODE valtozojanak 0-ra allitdsaval, €s a rajz Gjrageneralasaval.

Ha egyik modszerrel sem akarunk bajloédni, akkor hagyjuk utoljara a sraffozast, ugyanis a
14-es AutoCAD a zart teriiletek keresésénél nem veszi figyelembe a méretek jelenlétét, tehat a
méretek nem zavarjak a sraffozast.
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7.5.2. A méretsegédvonalak megszakitasa

Az eddig elkésziilt rajzon lathato, hogy egyes méretsegédvonalak méretnyilakat metszenek.
Ez nem megengedett. Azt is tapasztalhattuk, hogy a segédvonalak megszakitasa (Modify = Break)
nem lehetséges. Ennek az az oka, hogy alapértelmezettként a megadott méretek egyetlen
rajzelemnek tekintheték (ez fiigg a DIMASO valtozd értékétdl is). Szétrobbantasuk utdn mar
modosithatéak az egyes vonalak, igy a segédvonalak megszakitdsa is lehetségessé valik. Ez a
modszer mégsem ajanlott.

Fontos megjegyezniink, hogy a méreteket csak abban az esetben szabad szétrobbantanunk,
ha erre feltétleniil sziikség van. Ennek okai a kovetkezdk:

— Tegylik fel, hogy a kész miithelyrajzunkrol akarunk egy kicsinyitett, M 1:2 méretaranyt
masolatot késziteni! A Modify = Scale paranccsal ezt a kicsinyitést egyszerien elvégezhetjik.
Az AutoCAD a méretezd valtozok értékeibdl tudja azt, hogy mekkora egy méretnyil, milyen
magasak a méretszamok, stb., ezért ezeket a kicsinyités sordn nem fogja modositani.
A szétrobbantott méretrél azonban mar csak egy szdveg, nyolc vonal és két sraffozas. Ennek
kovetkeztében a méretszam ¢és a nyilak is fele méretiire zsugorodnak.

— Ha pl. ennek a tengelynek modosul a kialakitasa, és a Modify > Stretch paranccsal
megnyuUjtjuk a 23 mm-es méretet 28 mm-re, az AutoCAD kiszamolja az 0sszes, modosuld
méretet, ¢s a méretszamokat az 0j értékekre modositja. Szétrobbantott méretek esetén ez a
funkcié sem miikddik.

— A méretezd valtozok hasznédlataval egyszerlien ¢és gyorsan modosithatjuk a meglévd
méreteinket, de csak akkor, ha azok nincsenek szétrobbantva.

A segédvonalakat a kdvetkezoképp szakithatjuk meg a méret szétrobbantasa nélkiil:

4:. 1x45° IR PP
| T I
1,7HI2 . . 1, 7HI2
e 1X 457 . e 1x45°

33. abra

A méret fogdpontjat huzzuk el a megfeleld helyre, majd a Line paranccsal rajzoljunk egy
vonalat a segédvonal eredeti végpontjaig!
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Adjuk meg a feliiletérdességeket is! A kezd6pont legyen a tengely palastjan, a végpontok

koordinatai pedig: [@3.5<120], illetve . [rjuk fo1¢ a 0,8 értéket a Draw > Text = Single
Line Text paranccsal irjuk a megfeleld helyre! (A parancs alkalmazasarol a kovetkezo gyakorlatban
lesz sz06.)

A fent leirtak alapjan méretezziik be az 6sszes, eddig elkészitett rajzot!

7.6. ELLENORZO KERDESEK

— Hogyan tud specialis karaktereket irni a méretszamokba?

— Miért nem célszerli szétrobbantani az elkésziilt méreteket?

— Nyujtsa meg a tengelyt a Stretch paranccsal! Figyelje meg a méretszamok megvaltozasat!
— Ttlntesse el, majd jelenitse meg ujra a méreteket!

8. HATODIK RAJZGYAKORLAT: SZOVEGMEZO ELKESZITESE, ES
BEILLESZTESE MAS RAJZBA

A gyakorlat soran elsajatitott fobb ismeretek:

a szovegiras modjai, szovegek igazitasa,
szovegek modositasa,
— attribatumok alkalmazésa.

Mint ahogy azt mar lathattuk, a kézi rajzoléssal ellentétben a CAD programokban a gyakran
hasznalt rajzrészleteket elég egyszer elkésziteniink. Ilyen elem a szovegmezd is.

Az AutoCAD sok, szabvanyos szdvegmezdvel ellatott, keretes rajzlapot tartalmaz, tehat
miel6tt nekifognank egy szovegmezd vagy barmilyen hasonld részlet megrajzoldsénak, ajanlatos
koriilnézniink a program Support alkdnyvtaraban 1évo referencidk kozt. Ezeket a mar ismert Insert
- Block vagy Insert = External Reference paranccsal szurhatjuk a rajzunkba. Utobbi
ismertetése megtalalhatd a Jegyzet: Az Insert menii parancsai c. fejezetében.

Most készitsiink el egy olyan szovegmez6t, amely nem szerepel a program altal felkinaltak
kozt. A kész rajzot az 34. abra mutatja.
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Ellendrzés: Targy: Méret-| Kertészeti és Elelmiszeripari
arany: Egyetem
ELELMISZERIPRAI
Nev: ATTRIB ATTRIB FOISKOLAI
& féenfzg KAR, SZEGED
- A Rajzszam:
ip}
o P.ISZABO ISTVAN R
T patum: Anyag: ATTRB ATTRIB ®
-+ IATTRIB ATTRIB Lapok szama: A[Sz.lap: ATTR
40
120 os)
135
160
200
34. abra

Rajzoljuk meg a befoglalo téglalapot (Draw -> Rectangle). A két sarokpont: (0,0) ;
(200,55). Ez egyetlen rajzelem. Mi azonban a kiilondllo oldalaival akarunk a tovébbiakban
dolgozni. Ehhez szét kell ,robbantanunk” a Modify = Explode parancs segitségével. Ha ez
megtortént, folytathatjuk a szerkesztést a belsd vonalak meghtizasaval.

8.1. PARHUZAMOS VONALAK VAGY KONCENTRIKUS IVEK
HUZASA
A korabban mar alkalmazott Modify = Offset (12-es és 13-as verzioknal Construct >

Offset) parancs segitségével meglévl rajzelemmel huzhatunk parhuzamost. Ezt kétféleképp
végezhetjlik:

— az eredeti rajzelemtdl meghatarozott tdvolsagra és oldalra (Distance, Side),
— meghatarozott ponton keresztiil (Through).

Ebben az esetben adott tavolsagokra fogunk a szovegmezd bal szélével parhuzamos
vonalakat htzni:

Command: offset
Offset distance or Through <Through>: 40 (Itt adjuk meg a tavolsagot.)

Select object to offset: (Valasszuk ki a bal oldali, fiigg6leges vonalat.)
Side to offset? (Itt a rajzelem megfelel6 oldalara kell mutatnunk, pl. a 20,20 pontra.)
Select object to offset: (Kiléphetiink a parancsbol.)

Az eljarast az egér jobb gombjaval ismételjilk meg. A tavolsagok: 120, 135, 160 mm.

Ezt kovetden htizzuk meg a vizszintes vonalakat. Rajzelemként valasszuk az also, vizszintes
vonalat. A tavolsagok: 8, 15, 25, 32, 35 mm.

Ha ezzel is elkésziiltiink tiintessiik el a felesleges vonalrészeket a mar ismert Trim
paranccsal. Ezt egy 1épésben is elvégezhetjiik, ha a vagoélek kivalasztasanal ablakkal kijeloljiik az
Osszes belsdé vonalat (35. abra), majd a vagni kivant objektumok kijelolésénél a torlendd
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szakaszokra mutatunk. A Trim parancs csak abban az esetben miikodik, ha a vagas utan a vagott
rajzelem egy része megmarad. Teljes rajzelemek nem tordlhetéek vele, ezt a Modify = Erase
paranccsal végezhetjiik el.

35. abra

8.2. A SZOVEGIRAS MODJAI, A SZOVEGEK IGAZITASA

Az AutoCAD hasznalata sordn az egyik leggyakoribb gond a magyar ékezetes betiik hibas
megjelenése. A probléma Osszetettsége miatt itt bdvebben nem térek ki ra.

A szdvegirasnak a 14-es verzioban két mddja van (mindkét parancs a Draw menii Text
almeniijébdl adhato ki):

— Single Line (egysoros),
— Multiline (tobbsoros) szoveg irasa.

Persze a Single Line Text is lehet tobbsoros. A kiilonbség nem a sorok szdmaban keresendd.
8.2.1. Single Line Text

A szdveg irdsanak egyszeriibb mddja. Ezt a modszert hasznalhatjuk a régebbi verzidkban is.
A parancs kiadasa utan (Draw -> Text -> Single Line Text) kivalaszthatjuk a szovegigazitas
modjat (Justify). Ez azt hatarozza meg, hogy a kezdOponthoz képest a szoveg hogyan helyezkedik
el. Ezek a pontok a széveg elsé sorat magaba foglalo téglalap jellemzd pontjai. Ezt a kezdépontot
kell megadnunk, amikor a szdveg helyét kijeloljik. A legfontosabb lehetdségeket a 36. dbra
mutatja:

Top Left Top Center Top Right
Middle Left Mi er Middle Right
Left Center Right
36. abra
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Az alapértelmezett a Left (balra) igazitas.
Ugyanennél a promptnal hatarozhatjuk meg azt, hogy az eldre bedllitott szovegstilusok
koziil melyiket akarjuk hasznalni (Style).

Ha az igazitdson vagy a stiluson elvégeztiik az esetleges modositasokat, kovetkezhet a
kezdOpont megadasa (egérrel vagy billentylizettel).

Ezt kovetheti a szOveg magassdganak meghatarozasa. Begépelhetjiik a megfeleld értéket,
vagy az egérrel kijelolhetiink egy masodik pontot (az elsé a szoveg kezddpontja volt). Ebben az
esetben a magassag a két pont kozti szakasz hossza lesz. Amennyiben a széveg stilusa tartalmazza a
magassagot is, itt mar nem kell megadnunk.

Megjelenik a windowsra jellemz6 szdvegkurzor (DOS-os verzidknal egy négyzet), ekkor

kezdhetjiik begépelni a szoveget. Uj sort Enterrel kezdhetiink, a szovegirast két Enterrel fejezhetjiik
be.

Az 1j sorok ,,0roklik” az elsé sor igazitasat. Az igazitasrol részletesebb informéciok a
Jegyzet Draw menii fejezetének Text almenii pontjaban olvashatoak.

8.2.2. Multiline Text

A Single Line Text paranccsal ellentétben az igazités itt nem a szoveg elsd sorat, hanem a
teljes szoveget magaba foglalo téglalap jellemzo pontjaival torténik (37. abra):

Top Left Top Center Top Right
Middle Left MiddlgCenter Middle Right
Left Center Right
37. abra

A szoveget a befoglald téglalap atlos sarkainak kijelolése utan egy parbeszédablakban
szerkeszthetjiik: Itt gépelhetjiik be a szoveget, itt allithatjuk be az igazitast, a betliméretet és a
betiitipust is. A 14-es AutoCAD ujdonsagai koz¢ tartozik a True Type betlikészletek alkalmazasa.

8.2.3. Szovegstilus
Mar volt sz6 a szovegstilusokrol. Ezek a szoveg kiillonbozo jellemzdit: a betlitipust, a t, és

esetleg a magassagot taroljak. A beallitast megkdnnyiti, hogy ezeket a jellemzoket stilusba foglalva
egyszerre modosithatjuk.
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Stilusokat a Format -> Text Style paranccsal tudunk létrehozni, illetve modositani.
A megjelend parbeszédablakban a kdvetkezd opcidk allnak rendelkezéstinkre:

— A Style Name mezoben hozhatunk 1étre uj, illetve torolhetiink meglévo stilusokat.

— a Font mezdben valaszthatjuk ki a stilus altal hasznalt betiitipust, illetve annak beallitasat
(normal, félkovér, félkovér-dolt, dolt). Megadhatunk allanddé magassagot is. Amennyiben 0-t
adunk meg, minden egyes szovegiraskor meg kell hatiroznunk a szoveg magassagat is, igy
kiilonb6z6 nagysagu betliket hasznalhatunk. (Ebben a gyakorlatban ez a javasolt beallitas.)

— Az Effects mezd lehetdségeit alkalmazva irhatunk fejjel lefelé, illetve jobbrdl balra, valamint
szélesithetjiik és donthetjiik is a betiiket.

Hozzunk létre egy 1j stilust, és allitsuk be a jellemzoket: Arial betiikészlet, 0 magassag.
(A True Type fontok legtobbje tartalmaz magyar ékezetes betliket, viszont a kirajzoltatasuk csak
nyomtaton megfeleld sebességli. Az AutoCAD shx fontjai mellett szol az, hogy ezeket a betiiket
egy csotollas plotter is gyorsan megrajzolja.)

Valtsunk at a vékony vonalak rétegére, és a Draw > Text - Single Line Text parancsot
hasznalva készitsiik el a kovetkezo feliratokat (hasznaljuk a Top Left igazitast):

— Ellen6rzés:

— Név:

— Datum:

— Targy:

— Anyag:

— Rajzszam:

— Lapok széma:

— Sz lap:

— Me¢éretarany: (Enterrel torhetiink sort)
—  Kész tomeg:

— anév (itt hasznaljuk a Fit igazitést)

A féiskola nevének irasahoz hasznaljuk a Draw = Text = Multiline Text parancsot! Ez
esetben a rendelkezésre allo hely atlos sarkait kell kijeldlniink. Hasznaljunk 3,4 mme-es betiiket és
Middle Center igazitést!

8.3. SZOVEGEK MODOSITASA

A beirt szovegeket ugyaniigy mozgathatjuk, masolhatjuk, stb., mint barmelyik rajzelemet.
Ezen kiviil lehetéségiink van a szoveg javitasara is. Ezt a Modify > Properties paranccsal
végezzik. A parancs kiaddsa utan jeldljiilk ki a moédositani kivant szoveget. A jobb gombra
megjelend parbeszédablak Text: beviteli mezdjében elvégezhetjiik a javitdsokat. Az ablak alsé
részén lehetdségiink van egyéb tulajdonsagok (igazitas, stilus, magassag, elforgatas, beszlrasi pont,
stb.) valtoztatasaira is. Sziikség esetén itt tudjuk keskenyebbre allitani a Méretarany, illetve Kész
tomeg: feliratokat is (Width Factor).

Multiline Text esetén a Modify Properties parancs ablakanak Full Editor nyomogombjaval
megjelenithetjiik a szovegszerkesztd ablakot.
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8.4. ATTRIBUTUMOK ALKALMAZASA

Az attribatumok olyan szdvegek, amelyeket blokk készitésekor hasznalunk fel. A blokk
beszlrdsa soran a program rakérdez az attribitumok tartalmara, azaz begépelhetjiik az 0 szoveget.
Az attributumok részletes ismertetése a Jegyzet: A Draw menil parancsai c. fejezetében
megtalalhato.

A targy attributum elkészitése:

— Adjuk ki a Draw = Block 2 Define Attributes parancsot!

— A megjelend ablak Prompt mezdjébe gépeljiik be: Targy, A Tag mezdbe pl.. ATTRIB. (Ez
utdbbinak itt nincs jelentdsége, de az adatok esetleges kigytlijtésekor mar igen.)

— Adjuk meg a beszurasi pontot (a téglalap kdzepét), valasszuk a Middle Center igazitast, és
allitsunk be 7 mm-es betlinagysagot, majd nyomjuk le az OK gombot! A szovegmezdben
megjelenik az ATTRIB felirat.

Hasonlé mddon hozzuk létre a tobbi attribtumot!

Végiil helyezziik at az origdt vagy a bazispontot a szovegmezO jobb alsé sarkaba, majd
toroljiik le az also vizszintes és a jobb oldali fiiggéleges vonalat. Erre a kovetkezok miatt van
szlikség:

— Teljes f3jl rajzba vald beszurasakor a beszurasi pont az eredeti fajl origdja (vagy a bazispontja,
ha modositottuk). Ennek a pontnak az 0j rajzon elfoglalt helyét kell kijeldlnlink. Az 10j rajz
keretén adott ez a pont, tehat meg tudjuk azt fogni, igy gyorsabb a beillesztés.

— A két vonal torlése azért sziikséges, mert a kereten mar megvannak ezek a vonalak. Ha a
kirajzoltatds nyomtatoval torténik, ennek nincs nagy jelentésége. A plotter azonban kétszer
hazna ki ezt a két vonalszakaszt: egyszer, amikor a keretet, és egyszer, amikor a szovegmezot
rajzolja. (A két vonalra elhasznalt tus mennyisége nem jelentds, de gondoljuk meg: majdnem
minden rajzunkhoz ugyanazt a szovegmezot fogjuk haszndlni.)

Készitsiink keretet és szarjuk be a szovegmez6t (Imsert = Block) az eddig elkésziilt
rajzainkba!

8.5. ELLENORZO KERDESEK

— Készitse el a szabvanyos méretli rajzlapokat, kerettel, szovegmezovel ellatva, allo és fekvo
fomratumban!

—  Miért célszerti attributumokat alkalmazni?

— Rajzolja meg egy nyomasmérd Ora szamlapjat a vonalak és szdmok polaris kiosztasaval!
A kiosztas utdn modositsa a nyomasértékeket!
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9. HETEDIK RAJZGYAKORLAT: MEREV TARCSAS

9.1. LEIRAS

A gyakorlat soran elsajatitott fébb ismeretek:

a haromdimenzios szerkesztés alapjai,

a szilardtestek 1étrehozasanak lehetdségei,
a szilardtestek modositasa, €lletorés, ¢llekerekités és a Boole-algebra alkalmazasa,
anyagtulajdonsagok alkalmazasa,

a szilardtestek fobb jellemzdinek lekérdezése,
miihelyrajzok készitése a modellrdl.

A kész rajzot a 38. dbra mutatja:

TENGELYKAPCSOLO MODELLEZESE

Blenorzas:

Hews

Taryy:

Meret—
any:

Kertoarati a8 Halmiszaripar
Erqyetemn
ELELMISZERIPAR! FEASKIOLA

o1
tomeg: Rojzazome
Dotum: ANynge
Lapak. szoma: [5ziop:
38. abra
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9.2. A HAROMDIMENZIOS SZERKESZTES ALAPJAI
A haromdimenzios szerkesztésben a kdvetkezd rajzelemeket kiilonboztetjiik meg:

— szilardtestek,
— droétvazak,
— feliiletek.

9.2.1. Szilardtestek

Tomor elemek. A szilardtestekhez anyagokat rendelhetiink: valaszthatunk a program éaltal
ismert anyagok koziil, de magunk is definidlhatunk tjakat.

Az alkalmazott CAD program szerves része a gyartasnak, hiszen a program (vagy annak egy
segédprogramja) szamolja ki az NC forgacsologép szerszdmainak utvonalgorbéit, az alkalmazott
szerszamok fliggvényében.

9.2.2. Drotvazak
Nem kitoltott testek, hanem azok éleit abrazolo ivekbdl és vonalakbol allo objektumok.
9.2.3. Feliiletek

Segitségiikkel  lemezbdl  kialakitott ~ munkadarabok  modellezhetdk.  Kiilonb6zo
segédprogramokkal a palédstok kiterithetéek, igy novelhetjiik az élelmiszeriparban igen gyakran
eléforduld lemezmunkak pontossagat.

9.3. SZILARDTESTEK LETREHOZASA ES MODOSITASA
Szilardtesteket haromféleképp hozhatunk létre:

— primitivek segitségével (gomb, hasab, stb.),

— sikidomok egyenes vagy Utvonalgorbe-menti kihtizdsaval (ilyen test pl. egy vasuti sin vagy egy
spiralrugo),

— sikidomok megforgatasaval (ilyen a gyakorlatban szerepld tengelykapcsolo).

A létrehozott szilardtestet tovabb alakithatjuk:

—  letorhetjiik,

— lekerekithetjiik az éleit,

— elvaghatjuk a testet egy sik mentén,

— alkalmazhatjuk ra a kétdimenziés parancsokat vagy azok 3D-s megfeleldit (mozgatas, masolas,
titkkrozés, kiosztas, stb.),

— masik szilardtest segitségével is modosithatjuk, a Boole-algebrat alkalmazva (unid, metszet,
kivonas).
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9.4. MUHELYRAJZOK KESZITESE A MODELLROL

A CAD programok segitségével a 1étrehozott testrdl egyszeriien készithetlink miihelyrajzot:
meg kell adnunk a lap méretét, valamint azt, hogy mely nézeteket és metszeteket akarjuk abrazolni
a rajzon. Egyes programok (pl. az Autodesk Mechanical Desktop) ezeket automatikusan be is
méretezik.

9.5. A GYAKORLAT LEPESEI

Fontos szem el6tt tartanunk a kovetkezoket:

— Egérrel torténd pontmegadaskor a Z koordinata mindig 0, tehat nem a képerny6 sikjan, hanem
az X-Y sikon adunk meg pontokat. Hosszmegadasnal ez megtévesztd lehet.

— A fogopontok a fentiekkel ellentétben mindharom koordinatat kovetik. Ha pl. egy vonal
végpontjat jeloljiik ki, akkor valoban a végpontot, €s nem az X-Y sikon 1évd vetiiletét fogjuk
meg.

9.5.1. A tarcsafél megrajzolasa

Kezdjiink egy 0j rajzot (New). Ha még nem latszanak, jelenitsiikk meg az UCS ¢és a Solids
eszkoztarat (View = Toolbars). Valtsunk at a kozépvonalak rétegére, és huzzuk meg vizszintesen
a tarcsafél tengelyvonalat (Layer, Line). Helyezziik ra egy pontjara az origo6t (Origin, Nearest).

Viltsunk at a vastag vonalak rétegére, és rajzoljuk meg a tarcsa metszetének felso részét, a
letorések és a lekerekitések nélkiil, ahogy azt a 39. dbra mutatja (Layer, Line). Ezt a sikidomot
fogjuk korbeforgatni a pontvonal koriil. Ehhez a vonalaknak pontosan kell zaroédniuk. Az elsé pont
legyen a 0,25. Az utolsé eldtti pont megadasat megkonnyithetjiik a koordinatak szlirésével: az X
koordinata megegyezik az elsé pont X koordinatajaval.

39. abra

Sajnos ezeket a vonalakat az AutoCAD még nem tudja koriilforgatni, elébb ezeket
Osszefliggd polivonalla kell alakitanunk. Gépeljiik be a pedit parancsot, majd mutassunk ra
valamelyik vonalra, pl. a bal oldali fiigg6legesre:
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Command: pedit

Select polyline: (Valasszuk ki a fiiggdleges vonalat.)
Object selected is not a polyline

Do you want to turn it into one? <Y¥Y>

Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype
gen/Undo/eXit <X>: ] (Join — csatlakoztatjuk a tobbi vonalat az el6z0hoz.)

Select objects: Other corner: 5 found (Hasznaljunk ablakos kijelolést!)
Select objects:
5 segments added to polyline

Open/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Undo/eXit
<X>: (Lépjiink ki a parancsbol!)

A hat vonal most mar egy rajzelemet alkot.

Kovetkezhet a korbeforgatas. Ezt a Draw => Solids = Revolve paranccsal végezziik (az
ikon a Solids eszkdztarban talalhato):

Command: revolve
Select objects: 1 found

Select objects:

Axis of revolution - Object/X/Y/<Start point of axis>:

(Adjuk meg a pontvonal egyik végpontjat!)
<End point of axis>: (Adjuk meg a masik végpontot!)
Angle of revolution <full circle>: (Teljes koriilforgatast kell valasztanunk.)

Ne feledjiik el, hogy a rajzolést feliilnézetben kezdtiik, tehat amit most latunk, az a tarcsa
feliilnézete.

Torjik le, illetve kerekitsiik le a megfeleld éleket! A Chamfer, illetve Fillet parancsot a
kétdimenzids rajzolasban megszokottak szerint kell hasznélnunk. Az eltérés annyi, hogy itt nem két
vonalat, hanem egy ¢t kell kijeldlniink. Ehhez elébb el kell forgatnunk a testet, hogy az élek
lathatova valjanak. Ezt a View = 3D Viewpoint = SW Isometric paranccsal végezhetjiik el (40.
abra). A letorések elott helyezzilk az UCS origojat a 40. abra 2. pontjaba (a nagy furat bal
homlokfeliileti kvadrans pontjaba). Ennek a reteszhorony megrajzolasakor lesz jelentdsége.
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40. abra

Ha elkésziiltiink a letdrésekkel €s a lekerekitéssel, kovetkezhet a reteszhorony ,,marésa”.

7 ¢ N

41. abra

Ehhez egy hasdbot hozunk Iétre, majd kivonjuk azt a tarcsabol. Valtsunk at a jobb
oldalnézetre (View = 3D Viewpoint 2 Right), majd az UCS-t igazitsuk a képerny6hoz (Tools >
UCS > View). Rajzoljuk meg a retesz keresztmetszetét a 41. abra szerint, a Draw - Rectangle
parancs segitségével. Valtsunk at SW izometrikus nézetre, ¢és ellendrizzik a téglalap
elhelyezkedését. Ez 6sszefliggd rajzelem, tehat maris kihtizhatjuk a Draw > Solids > Extrude
paranccsal:

Command: extrude
Select objects: 1 found

Select objects:

Path/<Height of Extrusion>: Second point: (A kihuzas hosszanak megadasa.)
Extrusion taper angle <0>: (A szogérték esetiinkben csonkagulat eredményezett volna.)
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A kihuzas hosszanak megadasa a fenti példaban két ponttal: a nagy furat koreinek kvadrans
pontjaival tortént (42. dbra, 5., 6. pont). A hossz tehat a furat alkotdja. Az AutoCAD nem veszi
figyelembe a két pont megadasanak sorrendjét, a kihuzas a Z tengely pozitiv iranyaban torténik. Ha
a masik iranyt szeretnénk vélasztani, akkor negativ értéket kell begépelniink. (Itt a pozitiv irdny a
megfeleld.)

42. abra

A hasab kivonasa a tarcsabol a Modify = Boolean = Subtract paranccsal torténik:

Command: subtract Select solids and regions to subtract from...
Select objects: 1 found (Valasszuk ki a tarcsat!)
Select objects:

Select solids and regions to subtract...

Select objects: 1 found (Valasszuk ki a hasabot!)

Select objects: (Kilépés.)

A 6 furat megrajzoldsdhoz helyezziik az origdt a bal homlokfeliilet kdzéppontjara, majd
jelenitsiik meg a jobb oldalnézetet (View - 3D Viewpoint = Right). Rajzoljuk meg az els6
furatot, majd osszuk ki a tarcsa kozéppontja koriil (Draw > Solids ->Cylinder; Modify ->
Array):

Command: cylinder

Elliptical/<center point> <0,0,0>: 0,77.5
Diameter/<Radius>: 7,5

Center of other end/<Height>: Second point:

Command: array
Select objects: 1 found

Select objects:

Rectangular or Polar array (<R>/P): p
Base/<Specify center point of array>:
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Number of items: 6
Angle to fill (+=ccw, -=cw) <360>:

Rotate objects as they are copied? <¥Y>

Vonjuk ki a hengereket a tarcsabol, majd torjiik le a furatok éleit. A kész tarcsafelet a 43.
abra mutatja.

Kérdezziink le a tarcsafél adatait a Tools = Inquiry = Mass Properties paranccsal.

Az Osszeallitasi rajzhoz tikkrozhetnénk a tarcsafelet a Construct = Mirror 3D paranccsal
(ez abban tér el a kétdimenzids tiikkr6zéstol, hogy tiikortengely helyett egy sikot kell definidlnunk),
most azonban készitsiik el a tarcsafél mithelyrajzat!

9.5.2. A miihelyrajz elkészitése

Lépjiink at a Papir Térbe (View - Paper Space). Az Insert 2 Block parancs File
opcidjaval szurjuk be a keretezett, szovegmezovel ellatott A3-as fekvo rajzlapot.

A papir térben a View > Viewports = 4 Viewports segitségével tudjuk a nézeteket a
papirra helyezni. A parancs kiadasa utan egy téglalapot kell kijeldlniink. Ezen a teriileten fog
elhelyezkedni a négy nézet. Toroljiik le a bal alsot a Modify = Erase parancs segitségével!

Térjiink vissza a Modell Térbe a View - Model Space (Floating) paranccsal! Ezt kovetéen
a nézetek kozt a szalkereszttel valthatunk, az aktualis nézetet pedig az eddig megszokottak szerint
szerkeszthetjiik. Hozzuk létre a tarcsa megteleld nézeteit az szerint!

9.6. ELLENORZO KERDESEK

— Milyen 6sszetett rajzelemeket tudunk létrehozni a haromdimenzids szerkesztés soran?
— Milyen médon tudjuk ezeket 1étrehozni?
— Ismertesse a Boole-algebra miiveleteit!
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